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General Information

1 General Information

For the sake of readability, gender-neutral endings are not used in this operation manual. It is hereby expressly stated
that all parts of the text where natural persons or groups of persons are mentioned refer to people of all genders.

1.1 Information about this manual

Before beginning any work on the machine, read this manual completely and carefully.
Keep the manual for further consultation close to the machine.

This manual must be read and observed before commissioning and operating the soware and the corresponding laser
system. Failing to observe individual points listed in this manual may result in personal injury and/or material damage
to property. This soware may only be used to operate systems containing devices and spare parts included in the
scope of supply or the replacement or wear and tear parts list. Ancillary devices must be calibrated to meet the safety
and operational requirements of the base machine (please contact your dealer or the manufacturer with any queries).

1.2 Explanation of symbols

Important technical safety notes and instructions in this manual are indicated by symbols. It is important to observe
and follow these notes and instructions on workplace safety. Avoid accidents, personal injury and material damage to
property by acting with extreme caution.

Warning Laser
This symbol warns of potentially dangerous situations related to the laser beam. Failure to observe the
safety instructions leads to risk of serious injury.

Caution
This symbol indicates a potentially hazardous situation which, if not avoided, could result in minor or
moderate injury.

Notice
This symbol indicates potential risks of damage to the supported product (or to property).

In addition, non-observance may result in damage, malfunction or failure of the machine.

Information
This symbol indicates tips and information which must be observed for efficient and trouble-free handling
of the product.
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1.3 Liability and warranty

Warranty periods specified in the manufacturers "warranty terms and conditions" shall be binding for the buyer. If no
warranty periods are specified, the general terms and conditions of sale, delivery and payment apply.

All information, illustrations, tables, specifications and diagrams contained in this operating manual have been carefully
compiled according to the current state of technology. No liability is accepted with regard to errors, missing information
and any resulting damage or consequential loss.

Strict compliance with the safety procedures described in this operating manual and extreme caution when using
the equipment are essential for avoiding and reducing the possibility of personal injury or damage to the equipment.
The manufacturer shall not be liable for any damage and or faults resulting from nonobservance of instructions in this
manual.

Nonobservance of the operation, maintenance and service instructions described within this manual absolves Trotec
Laser GmbH from any liability in case of a defect.

Furthermore, Trotec Laser GmbH shall accept no liability whatsoever for damage caused by the use of non-original parts
and accessories.

Additionally, Trotec Laser GmbH shall not be held responsible for any personal injury or property damage, of an indirect
or specific nature, consequential loss, loss of commercial profits, interruption to business, or loss of commercial
information resulting from use of the equipment described in this manual.

It is strictly prohibited to make any alterations, to prepare translations, decompile, disassemble, reverse engineer or
copy the soware.

Trotec Laser GmbH reserves the right to update any of the information, illustrations, tables, specifications and diagrams
contained in this operating manual with regard to technical developments at any time without notice.

1.4 Computer requirements

When using a more powerful computer, the graphics are generated and displayed faster, and the computing times and
the times for data transfer to the laser are reduced.

The following recommendation represents the minimum requirements:

• Operating system:
Windows 7® 32/64-bit or Windows 10® 64-bit

• 1024 MB RAM, 200 MB hard disk
• Pentium® 1 GHz processor or AMD Athlon™ XP
• 1024 x 768 monitor resolution or greater
• 24-bit colour graphics card
• Serial port (COM port), (Alternatively a USB-to-COM converter is available)
• Computer mouse
• The requirements can vary depending on the type of laser system
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COMPATIBILITY

Notice
Soware with the same version number (first two digits) must be used for various Trotec soware
components to work together smoothly. The last digit of the version number is irrelevant (X.X.X). Example:
SpeedMark 3.7.x will only function with TLC2 module 3.7.x.
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2 Safety

TO AVOID POSSIBLE HARM READ AND FOLLOW THESE INSTRUCTIONS.

The SpeedMark soware is at the current development status at the time of delivery with your Trotec laser system from
the Galvo product line.

The machine is built at the time of it's development and production according to applicable, established technical rules
and is considered to be safe to operate.

Dangers can be caused by the machine if the machine:

• is operated by unqualified personnel,
• the personnel have not been trained,
• the machine is used improperly or not as intended,
• or if the machine is used for other intended purposes.

Notice
Always read and follow the operating instructions of the Trotec laser system you have purchased.

2.1 Intended use

The SpeedMark soware described in this manual is used with Trotec laser systems of the Galvo product line.

The system must be operated, maintained and repaired only by trained personnel familiar with the designated field of
use and the dangers of the machine!

The marking process may only be carried out when the machine is properly adjusted (see also the operating
instructions of the Trotec laser system you have purchased).

The intended use of this machine also includes that all personnel involved in installation, set-up, operation
maintenance and repair of the machine must have read and understood the operating manual and in particular the
“Safety” section, and comply with the instructions.

Organisational measures:

• Personal protective equipment
• Inspection of the laser protection wall
• Laser safety instructions/laser safety training
• Monitoring by Laser Safety Officer
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2.2 Not intended use

Use of the machine in areas other than those described in the intended use or in this document is considered contrary
to the intended use and is prohibited. The manufacturer accepts no liability for any resulting personal injury and/or
damage to property. The operator alone is liable for all damage caused by improper use.

Non-observance of the operating, maintenance and servicing instructions described by the manufacturer in the
operating instructions excludes the manufacturer's liability in the event of a defect.
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3 First Steps

3.1 Installation of the SpeedMark Soware

Information
The SpeedMark soware is designed to simplify the operation of your laser. It may be used to control
all laser functions via the computer and set all parameters. Constant communication between the
SpeedMark soware and the laser ensure a smooth working process.

The following installation instructions provide a brief overview of the SpeedMark soware installation process. Detailed
operating instructions for Windows® can be found in the Windows®user guide.

1. Start Windows®

2. Start the SpeedMark Setup-Program.

3. The programme guides you through the menu-driven installation routine and then copies all the necessary files
to your hard disk - for more information on upgrading and uninstalling the SpeedMark soware, see "Installation
Manual".

a The installation process is complete.

3.2 Starting the SpeedMark Soware

Information
To start the SpeedMark soware, the set-up program adds an icon to the Windows Desktop® and the Start
menu. SpeedMark may be started using either of these.

FILE ASSOCIATIONS
On the first start SpeedMark will establish file associations with project files (.sprx). This will be visible in windows
explorer by special file icons (SpeedMark logo). These files can then be opened in SpeedMark by simply double clicking
them. If the program is already running and has an active project, SpeedMark will ask the user for a desired action (save,
discard, cancel), if there are unsaved changes. Aerwards the current project is closed and the double-clicked one will
get loaded.

LICENSING
Trotec SpeedMark will be delivered with a license key for the usage of this application. If you have not received the
appropriate keys please contact the dealer of your laser system. The license codes can be registered aer starting
SpeedMark via menu point Help ➜ Soware registration.

INITIAL USER RIGHTS
By default SpeedMark is shipped with limited user rights to avoid accidental changes of the configuration.
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Notice
SpeedMark is configured with an initial administrator password. Please change this password to protect
your system from unauthorized access (see chapter Initial user rights).

SCOPE OF APPLICATION OF SOFTWARE

The SpeedMark soware may be used to:

• Control the supplied laser system.
• Mark vector and bitmap images.
• Create your own graphics.
• Create dynamic user programs.
• Implement user programs.
• Control external hardware.

18



User interface

4 User interface

This chapter of the user manual explains the design and structure of the SpeedMark user interface in detail. It includes
all the functions controlled using the menus and toolbars.

The user interface pictured above represents a standard view of the SpeedMark soware - for adjustement of various
SpeedMark views see chapter "Desktops and User Rights Control".

It basically consists of the following areas:

• Main menu
• Toolbars
• Window for drawing and importing graphics.
• Window for editing the drawing and programming elements.

4.1 SpeedMark programs

This chapter provides a brief introduction to the structure and design of the SpeedMark programs. A more detailed
description of each concept is contained in the following chapters. Contrary to other laser marking applications,
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SpeedMark files are known as programs. This name takes into account that within SpeedMark it is possible not only to
specify the flow of marking processes in series, but also create a dynamic flow using the programming constructs.

4.1.1 Basic SpeedMark program for simple laser marking

The following example illustrates a basic SpeedMark program used to mark 4 graphics and a text with the laser.

As illustrated by the flow chart, the first the line and the circle are marked, followed by the text and then the rectangle
and the arc. The flow may be adjusted by changing the order of the individual elements.

Information
The user does not require any programming knowledge to perform this type of laser marking. All steps
can be carried out with confidence and ease using fixed, defined elements.

4.1.2 Dynamic SpeedMark program

The following example illustrates a dynamic SpeedMark program which uses settings to mark 4 lines and a text.
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As illustrated by the flow chart, just one line is marked to start with. Then SpeedMark checks whether the text should
be marked or not. Based on this decision, the text or the line is marked next. Then another line is marked. In the next
grinding element, the line is then marked four times.

Notice
Rudimentary programming knowledge offers a distinct advantage with this type of laser marking.
However, programming knowledge is not a requirement for the basic operation of the SpeedMark flow
control.

More detailed descriptions of the use of dynamic programs can be found in Chapters "Basic flow chart
programming" and "Simple Scripting".

4.1.3 Main-Program and associated sub-programs

In SpeedMark it is possible to store graphic markings and flows in sub-programs which not only help maintain clarity in
the master program but also allow dynamic programming.
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In this instance, the master program illustrated above has two sub-programs which may be used by the master program.

Information
Advanced programming knowledge offers an advantage with this type of laser marking. This type of
programming is mainly used in industrial environments employing repetitive tasks of long duration.

More detailed descriptions of the use of master programs in combination with sub-programs can be
found in Chapter "Simple Scripting".
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4.2 User interface windows

4.2.1 Flow diagram with Flow chart

The flow diagram illustrates the current flow chart of a SpeedMark program. Each
program contains a start and at least one end node. It is possible to add as many graphic,
control or programming elements in between as required.
This type of illustration provides a quick and simple overview of the way and order in
which programs are processed and marked.

Elements containing sub-elements are marked with  and can be collapsed (e.g., to

improve clarity on the flow chart). Collapsed elements are tagged with  . Clicking on the
respective items toggles the state.
Programming elements can be used to introduce a dynamic flow to programs.

4.2.2 Drawing interface

The SpeedMark drawing interface stores all the graphic elements to be marked by
the laser.
Graphics can be positioned easily using the grids and rulers.
The outer rectangular border indicates the actual working area and field size of the
laser system. This border is determined by the calibration. Any graphics located
outside this boarder cannot be marked by the laser.
All the graphic elements stored in the drawing interface can be edited using the
mouse. A more detailed description of how to edit elements can be found in
Chapter "Editing Graphic Elements".
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4.2.3 Graphic properties

All SpeedMark graphic elements can be edited using the graphic properties in the
Graphic properties window.
The properties of each individual element can be adjusted in the Graphic tab (the
example on the right contains those of a linear element). The entries in the Graphic
tab will therefore differ according to the graphic element selected.
The other tabs such as Marking, Source, Filling, Transformation and General contain
common graphic element properties which remain the same for all elements.
Any properties which cannot be applied to graphic elements (e.g., filling for lines)
are greyed out.
All changes are confirmed by pressing “Enter” or on exit of the input field.

4.3 Tools toolbar functions

The Tools toolbar can be used to create new elements on the drawing
interface and in the flow chart. The elements are grouped into
categories.

4.3.1 Select and zoom tools

Mit Hilfe der Auswahlwerkzeuge können verschiedene Aktionen zur Veränderung der Ansicht der Zeichenoberfläche
durchgeführt werden.
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Werkzeug Name Beschreibung

Select Selects one or more elements

Hand Drags and drops the drawing interface into a new position

Measure Provides the possibility to measure objects on the drawing area

Next View Switches to the next zoom view. If there is no further zoom view, this will not
function

Previous View Switches back to the previous zoom view

Magnify Magnifies the zoom on the drawing interface. This is referenced according to the
centre of the drawing interface

Demagnify Demagnifies the zoom on the drawing interface. This is referenced according to
the centre of the drawing interface

Window Size Zooms in to the drawing interface to display the entire editing field

Selected Zoom in on all selected graphic elements

4.3.2 Graphic elements

Graphic elements can be used to create a variety of graphical elements on the drawing interface. These elements can be
generated in both the drawing interface as well as the flow chart. - More information on the editing and application of
graphic elements can be found in Chapter "Editing Graphic Elements".

Element Name Description

Line Creates a line on the drawing interface.

Ellipse/Circle Creates a circle or an ellipse on the drawing interface.

Curve Creates a curve on the drawing interface.

Rectangle Creates a rectangle on the drawing interface.

Text Creates a text element on the drawing interface.

Outlinetext Creates an outline text element on the drawing interface.

Barcode 1D Creates a barcode on the drawing interface.

Barcode 2D Creates a data matrix on the drawing interface.
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Vector Graphic Creates a vector graphic element imported from an existing file into
the drawing interface.

Vector Graphic from PDF
(must be unlocked in the
licenses)

Creates one or more vector graphic elements from an existing PDF file
into the drawing interface.

Raster Graphic Creates a raster graphic element imported from an existing file.

Import Creates a raster graphic element imported from an existing import file.
An import file may be one of several formats.

4.3.3 Graphic operations

The graphic operation tools are used to apply special operations on graphic elements.

Tool Name Description

Graphic array All graphics within this element are multiplied in a grid.

Deep engraving Allows the marking of a graphic multiple times inclusively rotation of the
filling and adoption of the z-axis.

Focus Shi Allows the marking of graphics on different focus levels.

4.3.4 Control elements

SpeedMark programs use the control elements to react to external events such as I/O values, user inputs, etc. These
elements can only be created in the flow chart - More information on the editing and application of control elements
can be found in Chapter "Control elements".

Element Name Description

Input Window Allows the user to enter configurable input values via the keyboard or
barcode scanner

Dialog window Information window to present user messages, inclusive Yes/No/Cancel
queries.

Value selection Allows to select an entry from a configurable value list

File selection Selection of a filename

Counter Counter element to control the marking executions
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Element Name Description

Variable editor Element for handling dynamic data

Wait forFor Signal Waits for a configured signal from an I/O input or the user to press a button.

Set I/O Output Sets an I/O output for a configured I/O card

Serial (RS232) Sends or receives data via a configured serial port component

TCP communication Sends or receives data via a configured TCP component

Delay Delays program execution for a set period

Move axis Moves selected axis

Control exhaust Controlling the exhaust

Border marking Starts border marking and waits for a signal from the operator

Print Prints the currently visible drawing area

Reading codes Code detection allows a simple detection of codes.

4.3.5 Programming elements

Programming elements give SpeedMark programs a dynamic component. These elements can only be created in the
flow chart - More information on the editing and application of programming elements can be found in Chapter "Simple
Scripting".

Element Name Beschreibung

Calculation/Allocation Enables the creation of program structures in the SpeedMark
script language for the calculation and allocation of variables

Comment/Note Adds a comment to a program

Program End Jumps to the program end element

Program abort Aborts a program
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Element Name Beschreibung

Branch Creates branches for adding alternative program flow

Multiple branch Evaluates a value and jumps depending on it to one of multiple
program flows

Incremental Loop Creates loops with preset start and end values and increments

Conditional Loop Creates loops which end according to a specified condition

Jump Label Defines a jump label within a program

Jump to Jump Label Jumps to a jump label

Jump to Sub-Routine Carries out a sub-routine

Jump Back out of Sub-Routine Returns out of the sub-routine

Sub-Program Opens a sub-program

External Program Opens an external program

4.3.6 Favourites

Favourites are used to gain easy access to
frequently used elements in the toolbar. This
section will always be displayed as the first
one in the toolbar.

To add an element to the favourites click on it
with the right mouse button and select "add
to favourites". If the element already exists in
the favourites nothing will be done.
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To remove an entry from the favourites
section, right-click on it and select "remove
from favourites"..
Entries in the Favourites section can be
reordered by drag and drop.

Notice
Favourites are saved with the desktop! It is not done automatically. So be sure to save the according
desktop each time they are altered. Another way to save them (if only one desktop is used) is to enable
"save desktop on exit" in the program settings.

4.4 Menu and toolbar functions

The main menu is displayed at the very top of the
program window by default.

The most oen used functions can be accessed via
the standard toolbars using the mouse.

The status bar contains the status of various
programs.

4.4.1 File menu

Menu item Symbol Description

New/ New project Creates a new master program in SpeedMark.

New/ New project from
template…

Creates a new program based on a template file The calibration tools can
also be found here.

New/ New Sub-Program Adds a new sub-program to an existing master program.

Open Opens a master program or sub-program

Save Saves the current master or sub-program

Save As Saves the current master or sub-program under another name or directory

Save as template Saves the current program as a template file

Close Closes the current program

Print Prints the currently visible drawing area

Recently used List of last 5 projects that were open in Speedmark, so they can be reloaded
easily
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Menu item Symbol Description

Quit Quits SpeedMark and closes all open programs

4.4.2 Edit menu

Menu item Symbol Description

Undo Undoes the last action performed on a graphic element.

Redo Redoes the last Undo action performed on a graphic element.

Cut Cuts an element from the flow chart or drawing interface and places it on
the clipboard for future use.

Copy Copies an element from the flow chart or drawing interface and placed it on
the clipboard.

Einfügen Insert

Delete Deletes an element from the flow chart or drawing interface.

Select All Selects all elements in the flow chart and the drawing interface.

Select All Graphics Selects all graphic elements in the flow chart and the drawing interface.

Toggle visible Toggles the state “Visible” for all selected graphics

Toggle active Toggles the state “Active” for all selected graphics

Graphic position locked Makes the graphic unselect able in the drawing area, thus preventing
unwanted changes. (only in popup menu!)

Graphic operations/ Grid
copy

Creates copies of all selected graphics in a grid.

Align/Le Aligns all selected graphic elements to the le-hand most element.

Align/Centre Aligns all selected graphic elements to the central vertical axis. The centre
being the vertical centre of all selected elements.

Align/Right Aligns all selected graphic elements to the right-hand most element.

Align/Top Aligns all selected graphic elements to the upper most element.

Align/Centre Aligns all selected graphic elements to the central horizontal axis. The centre
being the horizontal centre of all selected elements.

Align/Bottom Aligns all selected graphic elements to the bottom most element.

Properties Opens the properties dialog of a selected element. A graphic element
properties dialog is usually located at on the right-hand side of SpeedMark.

POPUP MENU
Most of these actions are also available in the popup menu (right click on an object). But some of them make only sense
on certain elements or under special circumstances. Because of this it may happen, that some actions are only available
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in the popup menu or are en-/disabled (e.g., creation of marking segments is only valid when segmentation is active at
all).

4.4.3 View menu

Menu item Description

Project admin Displays the Project Management window containing the programs currently
open.

Graphic properties Displays the graphic properties for a selected graphic element

Flow chart Displays the flow chart for the current selected program

Free Transformation Displays the Free Transformation dialog for editing one or more selected
graphic elements.

Project materials Displays the material manager for the current project material parameters

Material database Displays the material manager for the global material database

Tools Defines the layout and content to the tool selection bar (on the le):

• Favourites
• Select
• Zoom
• Graphics
• Edit
• Control
• Scripting
• AdvancedScripting
• Layout switches the design of the tool selection bar (outlook style or

grouped style).

Toolbars The Toolbars menu item contains all tool bars available within
SpeedMark:

• Standard
• Execute
• Debug
• Marking parameters selection
• Project
• Undo/Redo
• Graphic status
• Vision
• Measure

Debug windows The Debug Window menu item consists of several windows for
controlling dynamic programs:

• Variable Monitoring
• Error Messages
• Compiler reports
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Menu item Description

Operator windows The Operator Window menu item contains all windows used during on-
going operation:

• Execute Program
• Internal RunScreen
• Program Log
• Program Messages
• Execution counter
• Execution info

These operator windows are supported by the windows of individual
components, modules and program extensions.

Program extensions Displays a list of all windows of all installed program extensions

Vision Handles all options and settings regarding the camera module of
SpeedMark (if installed):

• Toggle video background
• Show main camera
• Show secondary camera
• camera snapshot
• Hide captured image
• Camera quick settings

Component windows Displays a list of components and their available windows depending on the
modules installed. This list depends on the configuration of SpeedMark.

System error Displays the system error window

Fullscreen Maximizes the Speedmark windows and removes the program border

4.4.4 Project menu

Menu item Symbol Description

Segmentation Performs segmentation on the current graphic elements for
usage with a movement axis.

Registration mark detection Activates and defines the regmark detection of the current
project. The regmarks help to align the graphics with the help of
the camera images.

Variables list In SpeedMark it is possible to set variables as place holders for
use within dynamic programs - see also Chapter "Variables".

Syntaxprüfung When dynamic programs are used, this menu item can
determine whether the syntax of all dynamic components has
been defined correctly - see also Chapter "Simple Scripting".

Pre- und Postprogramm Enables additional pre- and postprogram for the current
marking project.
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4.4.5 Start menu

Menu item Symbol Description

Quick mark Opens the Quick mark dialog for performing a one-off laser marking -
see also "Border marking".

Mark borders Draws a rectangular border round all graphic elements with the laser
pointer.

Execute Executes the master program and all associated sub-programs.

Simulate Simulates the master program and all associated sub-programs.

Debug Starts the program in debug mode. Interrupts the program flow at
specified breakpoints.

Individual Instruction Executes an individual program instruction.

Continue program Continues the program until the next breakpoint without interruption.

Stop program Stops the program.

Pause program Pauses the program. The program can be continued using “Continue
Program”.

Switch Breakpoint Sets or removes a breakpoint in a program instruction.

Remove All Breakpoints Removes all breakpoints.

4.4.6 Tools menu

Menu item Description

Switch User Switches the current user using a login if the user rights control is
activated.

Switch desktop Switches between the saved desktop layouts and provides the
possibility to save the current one.

User Rights and Desktops Allows the configuration of user rights control - see "Desktops and
User Rights Control".

Program Extensions Opens the Program Extensions dialog for configuring the installed
extensions - see "Extensions".

Laser system configuration Opens the Components dialog to configure the installed modules and
their associated components - see "Laser System Configuration".

Axis control All configured axes can be reset or controlled.

Scripted RunScreen Enables the user to create a user interface via advanced scripting that
can be run aerwards.

Konfiguration sichern/wiederherstellen Alle Konfigurationsdateien werden in einer Datei gesichert und
können auch aus dieser wiederhergestellt werden.
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Menu item Description

Settings Opens the SpeedMark configuration dialog - see "Configuring
SpeedMark".

System profiles Makes it possible to switch quickly between various system settings
(profiles).

4.4.7 Windows menu

Menu item Symbol Description

Arrange Horizontally Arranges the windows next to one another horizontally

Arrange Vertically Arranges the windows under one another vertically

Cascade Overlaps the windows on top of one another

Minimize All Minimises all windows

4.4.8 Help menu

Menu item Symbol Description

Soware registration Registering of the SpeedMark soware

Create service file Generates a file with all the necessary data to examine a machines
state (e.g., for bug analysis)

Start TeamViewer Starts the external program TeamViewer to enable technical help
through the Trotec support (Internet connection necessary)

About SpeedMark Displays the start dialog containing the version of SpeedMark in use
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4.5 Context menu functions

The SpeedMark context menu can be opened by clicking the right mouse button.
This applies to elements selected in both the flow chart and the drawing interface.
The individual functions are either activated or deactivated depending on the
element selected.

4.6 Shortcuts

GENERAL

Ctrl+F4 Exit SpeedMark

Ctrl+L Changing the user

PROJECTS

Ctrl+N New project

Ctrl+Shi+N New project from template

Ctrl+O Open project

Ctrl+S Save

Ctrl+Shi+S Save as

LASER CONTROL

F8 Quick mark

F9 Border marking

F10 Border marking positioning graphics

F11 Border marking selected graphics

F12 Execute
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EDIT GRAPHIC ELEMENTS

Ctrl+Z Undo

Ctrl+Y Redo

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste

Del Delete

Ctrl+A Select all graphic elements

Alt+1 Switch to flow chart

Alt+2 Switch to drawing interface

Alt+3 Switch to free transformation

Alt+Enter Switch to graphic properties

Pfeiltasten (Ablaufdiagramm) Switch between the elements

Pfeiltasten (Zeichenoberfläche) Move graphic element 1 mm

Ctrl+Pfeiltasten (Zeichenoberfläche) Move graphic element 0,2 mm

Ctrl+T Center selected graphic elements

CREATE GRAPHIC ELEMENTS

Alt+V Create vector graphic

Alt+R Create raster graphic

Alt+B Create barcode 1D

Alt+D Create barcode 2D

Alt+T Create outline text

ZOOM GRAPHIC ELEMENTS

Ctrl+“+“ Zoom in

Ctrl+“-“ Zoom out

Ctrl+0 (Null) Zoom to window

Alt+0 (Null) Zoom to selected graphic elements

MARKIERPARAMETER

F2 Open material database

F3 Open project materials

F4 Open parameter selection
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FUNCTION KEYS OVERVIEW

F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12

Materialdatabase Projectmaterials Parameterselect Quickmark Bordermark

(alle)

Bordermark

(pos)

Bordermark

(selek)

Execute
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5 Editing graphic elements

38



Editing graphic elements

5.1 General

5.1.1 Creating a graphic element

The Tools toolbar can be used to create new elements on the drawing
interface and in the flow chart.
Clicking on section Graphics opens a list containing all the graphic elements
available. A graphic element is selected by clicking on the respective element
once with the mouse. The cursor then changes, and the element can be
inserted in the flow chart or drawing interface.

Information
Double-clicking on a graphic element enables an element to be
inserted several times on the drawing interface. Click once with
the mouse and it immediately reverts to the Select tool once
the element has been inserted in the drawing interface.

However, if you do not want to insert the selected element, simply reselect the Select tool.

CREATING AN ELEMENT IN THE FLOW CHART
To create a graphic element in the flow chart, click on the graphic element to be
created and move the mouse cursor to the place in the chart where the element
should be inserted.
The currently selected insertion position will be marked by a green rectangle.
Areas containing an invalid insertion position are indicated by a mouse cursor in the
form shown here.

Once the insertion position has been confirmed by a single click, a settings dialog
opens for the respective graphic element in which the basic graphic properties may
be adjusted before the element is inserted.

   

CREATING A GRAPHIC ELEMENT ON THE DRAWING INTERFACE
To create a graphic element on the drawing interface, click on the graphic element to be created and move the mouse
cursor to the place where the element should be inserted. Once the insertion position has been confirmed, a single
click opens the settings dialog for the respective graphic element in which the basic graphic properties may be adjusted
before the element is inserted.

An additional insertion method (click-drag-drop) is available for the following graphic elements:
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Example line:

1. Click on the start position of the line with the mouse on the drawing interface but do not release the mouse button.
2. Continue to move the mouse cursor to the end position of the line.
3. Then release the mouse button.

5.1.2 Selecting elements

The Select tool can be used to select elements in both the flow chart and the drawing interface. 

The Select tool provides several options for selecting elements in the flow chart and the drawing interface:

• Make a single selection by clicking on an element in the flow chart or drawing interface
• Make a multiple selection by dragging a selection rectangle over the drawing interface
• Make a multiple selection by selecting the individual graphic elements on the drawing interface while holding down

the Shi key
• Make a multiple selection by selecting the individual graphic elements on the flow chart while holding down the

Shi key

5.1.3 Changing the view in the drawing interface

To better edit the graphic elements, the drawing interface can be adjusted to suit the editing requirements using the
Zoom and Drag functions.

THE TOOLS AND TOOLBARS DESCRIBED BELOW CAN BE USED FOR THIS PURPOSE:

Hand Drags and drops the drawing interface into a new position

Zoom Zooms in to an area selected with this tool

Next view Switches to the next zoom view. If there is no further zoom view, this will not
function

Previous view Switches back to the previous zoom view

Magnify Magnifies the zoom on the drawing interface. This is referenced according to the
centre of the drawing interface

Demagnify Demagnifies the zoom on the drawing interface. This is referenced according to
the centre of the drawing interface.

Window size Zooms in to the drawing interface to display the entire editing field

Selected Zoom in on all selected graphic elements
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5.1.4 Editing graphic elements

Selected graphic elements can be move on the drawing area with the cursor keys. There are three possible
combinations:

• Cursor keys: normal mode - moves objects 1mm by default
• CTRL+cursor keys: fine mode - moves objects 0,1mm by default
• SHIFT+cursor keys: fast mode - moves objects 10mm by default

5.1.5 Editing graphic elements with the mouse

The position, size, rotation angle and shearing of graphic elements can be adjusted directly using the mouse. This is

done using the Select tool. Graphic elements must be selected before adjustments can be made. 

The illustration to the right shows a selected text element with the
selection markers. Selecting an element automatically superimposes
nine selection points (squares and a central circle) which are used in
conjunction with the mouse cursor to adjust the element.

It is necessary to switch to rotation mode to rotate or shear an element.
This is done by clicking an already selected graphics a second time.
Rotation mode can be recognized easily by the arrows near the
selection points depicting the underlying transformation operation. It is
not possible to move the rotation point (the centre of the selection will
always be used as the reference point of the rotation/shearing action). If
needed this behaviour can be achieved via the transformation bar.
Clicking on an element again, that is already in rotation mode, it will switch back to move mode.

DRAGGING GRAPHIC ELEMENTS
Graphic elements may be dragged by using the mouse cursor in conjunction with the element’s central selection point.
The mouse cursor then changes its form to the mouse drag cursor.

The graphic element can be moved to a new position by clicking and holding down the mouse button while dragging

the mouse. Releasing the mouse button confirms the new position. 

ADJUSTING THE SIZE OF GRAPHIC ELEMENTS
It is possible to adjust the size of graphic elements by using the mouse cursor in conjunction with one of the outer
selection points. The mouse cursor then changes accordingly to one of the following forms:
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The size of the graphic element can be adjusted by clicking and holding down the mouse button while dragging the
mouse. Releasing the mouse button confirms the new size.

ROTATING GRAPHIC ELEMENTS
Rotating an element is done by grabbing one of the edge selections points while in rotation mode. Hold the mouse
button and rotate to the desired angle then release the mouse button to apply the change.

SHEARING GRAPHIC ELEMENTS
Shearing a selection is done like rotation. Grab one of the line selection points
while in rotation mode. Keeping the mouse button pressed and moving the mouse
performs the shearing. Release of the mouse button applies the change.

Notice
It is not possible to shear a radial text (will pop up an according message).

LOCKING OF GRAPHIC`S POSITION
To prevent unintended editing of certain graphics it is possible to lock their
position on the drawing area. There are three possible ways to enable this
mode.
Context menu (in the flow chart or
in the drawing area)

Graphic properties (Tab General)

Toolbar

To remove such a lock, all affected graphics must be selected in the flowchart,
then they can be unlocked via one of the three methods described above.
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5.1.6 Graphic properties

In addition to using the mouse cursor to edit the graphic elements, it
is also possible to adjusting the properties in the Graphic Properties
window.
This window can be used to specify and adjust additional graphic
element properties.

SpeedMark checks the plausibility of all changes made to the input
values before they are applied. If an error is found, it will be displayed as
in the illustration on the right.

5.1.7 Graphic properties of multiple elements

Doing a multiselect of graphic elements restricts which fields can be set via the graphic properties dialog.

The following tabs will stay active and can be changed:

• Marking
• Filling
• Transformation (without "dynamic transformation")
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Properties that are equal in all selected elements will be displayed normally.
Different values will be made visible depending on the field type:

Combobox empty or cyan background and shows value of first
element

Edit/Labels empty or invalid value (e.g., NaN)
Checkbox filled box (not checked, filled as a whole)
Changes will be made on each selected graphic individually, if the affected property
is supported by the element (e.g., filling will be ignored by a line).

5.1.8 Free transformation

If not already open, the “Free Transformation” function can be opened using the View "Free transformation" menu item.

Information
The “Free transformation” function also supports the editing of multiple selections of graphic elements. It
groups the elements together and applies all operations as if to one individual element.

The transformation functions are essentially divided into different groups:

Anchor point The anchor point defines from which point of a graphic
transformation operation should be performed.

Position To adjust the position, the X and Y values simply need to be
changed.

Size The size of the graphic elements can be adjusted in the
Size section by adjusting the height and width values. The
Proportional symbol is used to specify whether the entered
values should be automatically recalculated according to the
aspect ratio.

Rotation In order to adjust the rotation, the angle of rotation must be
specified in Grad. It is also possible to enter negative angles.

Mirroring Graphic elements can be mirrored directly using the “Horizontal
Mirroring” and “Vertical mirroring” buttons.
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Shearing Adjusting the shearing simply requires the adjustment of the
values in the Horizontal shear and Vertical shear input fields.

Advanced rotation To adjust the rotation a Rotation Point must first be defined
by specifying a value in the X and Y input fields. The angle of
rotation is also specified. It is also possible to enter negative
angles. Pressing the “Apply” button then applies these
adjustments to the graphic elements.

5.2 Creating and editing graphic elements

The following graphic elements are available in SpeedMark:

Graphic element Name
Line

Ellipse/Circle

Arc

Rectangle

Text

Outline text

Barcode

Data Matrix

Vector graphic

Vector graphic (from PDF)
This entry is only available if the PDF-
Import was activated in the licence keys.
Raster graphic

Import

Information
The following chapters contain
descriptions of how to insert the
graphic elements in the flow chart as
this option contains the most settings.
Graphic elements such as point, line,
ellipse and rectangle may all be created
directly on the drawing interface.

Complex graphics can be imported
easily into SpeedMark using the Vector
Graphics and Raster Graphic Elements.
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5.2.1 Line

Inserting a line opens the “New Graphic” dialog in which
it is possible to specify the exact start and end points. The
Graphic Properties window may be used to adjust these
values retrospectively.

5.2.2 Ellipse/Circle

Inserting an ellipse/circle opens the “New Graphic”
dialog in which it is possible to specify the centre,
the diameter, and the starting angle. The Graphic
Properties window may be used to retrospectively
adjust the starting angle only. The other properties
may be adjusted via the Transformation window.
The starting angle of the ellipse/circle element is used
to specify the point from which the laser should begin
marking the element. This can be essential in time-
critical applications to optimise flow. The default
setting of 0° is usually sufficient → represents the
furthest right-hand point on the graphic element.
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5.2.3 Arc

Inserting an arc opens the “New Graphic” dialog in which it is possible to specify the
centre, diameter, starting/end angle, and the arc closure. The Graphic Properties
window may be used to retrospectively adjust the starting/end angle and the arc
closure only. The other properties may be adjusted via the Transformation window.

The starting angle of the arc element is used merely to specify the point from which
the arc begins, and the end angle is used to specify the point where the arc ends
(please refer to the illustration to the right with a starting angle of 0° and an end
angle of 90°).

Activating the “Arc closed” checkbox specifies whether the arc is closed and
therefore displayed as a segment. In this form a vector filling may also be applied to
the arc. → when the arc closure is deactivated, so are all the filling settings.
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5.2.4 Rectangle

Inserting a rectangle opens the “New
Graphic” dialog in which it is possible
to specify the centre and the size.
The Graphic Properties window does
not contain any specific properties
although these may be adjusted via the
Transformation window.

5.2.5 Text

Inserting text opens the “New Graphic” dialog in which it
is possible to specify the various text parameters. All these
parameters may likewise be adjusted retrospectively in the
Graphic Properties window except for the Centre details
(which can be adjusted via the Transformation window).
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FONT
The text element font is a so-called single line font which produces the symbols using lines → Due to the use of single
line fonts, text elements may not contain any filling.

The following fonts are available in SpeedMark:

• ISOCT
• RomanS
• SOKOL

TEXT
The text to be displayed can be entered in the Text input field. It is also possible to enter multiple lines of text.

SIZE
This is used to specify the font size, and the line and character spacing. When specifying the font size, it is also possible
to specify the units used for the sizing parameters. The currently configured size units (in standard mm) and the font
size units in points are available for selection. The selected units are used for the both the line and character spacing
parameters.

With the checkbox “Abs height” the exact text height can be defined. The
reference character and the according height is the basis for the calculation of
all other characters. When no reference character is defined, the height will be
applied on the complete text of the text element.

TEXT STYLE
A text element may be displayed in various direction styles incorporating various display format properties.

Normal Text box

The text is displayed using the specified
font, text, and size parameters. These
parameters also determine the
behaviour of the element in relation
to the overall size of the element and
any transformations (i.e., when the size
is adjusted, the size of the font adjusts
itself automatically as the element
itself has become larger otherwise the
text will be distorted according to the
scaling).

In this instance, a text box is placed around the element when it is first
created (or this style applied). From this point on, this text box represents
the definitive border of the element. This border is also used to calculate the
alignment (le, right, centred). The textbox offers a set of scaling options, for
details see "Text box scaling options". This type of text style is mainly used
for markings on a workpiece of a specific size.
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Radial text

The radial text style is used to display the text in the form of a virtual ring marking defined by the Radius parameter.
Only the first line of multiple lines of text is displayed.

Circle text style Outer
The text is aligned on the outer side of the
virtual ring.

Circle text style Inner
The text is aligned on the inner side of the
virtual ring. Additionally, the orientation is set
here to counterclockwise.

Option Deltawinkel
The option delta angle allows the reduction of
the text length to a specified angle. Becomes
the text length greater, the text will be
compressed. With an angle value of 0° this
option is deactivated. Additionally, with the
button alignment it is possible to define if the
text should be aligned centred, le or right to
the angle.
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5.2.6 Outline text

Inserting text opens the “New Graphic” dialog
in which it is possible to specify the various text
parameters. All these parameters may likewise
be adjusted retrospectively in the Graphic
Properties window except for the Centre details
(which can be adjusted via the Transformation
window).

FONT
Outline Text elements may use any of the true type fonts available in your Windows® operating system.

TEXT
The text to be displayed can be entered in the Text input field. It is also possible to enter multiple lines of text.

SIZE
This is used to specify the font size, and the line and character spacing. When specifying the font size, it is also possible
to specify the units used for the sizing parameters. The currently configured size units (in standard mm) and the font size
units in are available for selection. The selected units are used for the both the line and character spacing parameters.
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With the checkbox “Abs height” the exact text height can be
defined. The reference character and the according height is
the basis for the calculation of all other characters. When no
reference character is defined, the height will be applied on
the complete text of the text element.

FONT EFFECTS
Outline Text elements may use bold and italic font effects. However, in this instance, bold only means that the respective
font parameter for this effect is applied. To actually make an Outline Text element bolder, this text must be shaded.

SYMBOLTABELLE
With the button right of the font effects
it is possible to open the symbol table
dialog to insert special characters into

the text field.  The amount and
kind of available symbols depend on the
chosen font.

TEXT STYLE
A text element may be displayed in various direction styles incorporating various display format properties.
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Normal
The text is displayed using the specified
font, text and size parameters. These
parameters also determine the behaviour
of the element in relation to the
overall size of the element and any
transformations (i.e., when the size is
adjusted, the size of the font adjusts itself
automatically as the element itself has
become larger otherwise the text will be
distorted according to the scaling).

Textbox

In this instance, a text box is placed around the element when it is
first created (or this style applied). From this point on, this text box
represents the definitive border of the element. This border is also
used to calculate the alignment (le, right, centred). This type of
text style is mainly used for markings on a work piece of a specific
size.

TEXTBOX SCALING OPTIONS
The textbox provides a simple way to restrict dynamic data to a predefined size. Depending on the selected scaling
options exceeding text is handled differently.

The following options are available:

• Scale X → scales text lines so, that they fit into the width of the text field.
• Scale Y →scales all text lines so, that they fit into the height of the text field.
• Single lines (affects only X scaling): → calculates a X scaling factor for each line independently, so only the font of

exceeding lines is shrinked. Otherwise the scaling factor of the longest line is applied to all lines.
• Limit strictly → if scaling is only active in one direction, it can happen that the text will exceed the other direction.

Limit strictly will remove such lines completely from the text. Otherwise these will be marked regardless of
exceeding the textbox.

Originale Textbox

Limit strictly
Will remove all exceeding lines, independently of any scaling options. This option will be disabled if X & Y scaling is
active (proportional).
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Scale X
Will shrink the font size of all lines, so that they fit into the textbox width.

Single Lines (only active, when Scale X is active)
Will act like Scale X, but calculates the scaling factor for each line independently

Scale Y
Will shrink the font size of all lines, so that they fit into the textbox height.

Scale X & Y
Will shrink the text proportionally. This means that the text will always fit into the textbox, because of this, all other
options are disabled.
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Radial text

The radial text style is used to display the text in the form of a virtual ring marking defined by the Radius parameter.
Only the first line of multiple lines of text is displayed.

Circle text style Outer
The text is aligned on the outer side of the
virtual ring.

Circle text style Inner
The text is aligned on the inner side of the
virtual ring. Additionally, the orientation is set
here to counterclockwise.

Option Deltawinkel
The option delta angle allows the reduction of
the text length to a specified angle. Becomes
the text length greater, the text will be
compressed. With an angle value of 0° this
option is deactivated. Additionally, with the
button alignment it is possible to define if the
text should be aligned centred, le or right to
the angle.
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5.2.7 Barcode 1D

Inserting a barcode opens the “New
Graphic” dialog in which it is possible to
specify the various barcode parameters.

BARCODE TYPE
Use this to select the type of barcode. A list of available barcodes in SpeedMark can be found in chapter "Barcode 1D
list".

BARCODE
Use this to enter the barcode applicable for the barcode type.

INVERT
The Invert checkbox is used to indicate whether a barcode should be displayed inverted and which quiet zone settings
should be used.

ADVANCED SETTINGS
Special settings depending on the chosen barcode type can be setup here.
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5.2.8 Barcode 2D

Inserting a data matrix opens the “New
Graphic” dialog in which it is possible
to specify the various data matrix
parameters.

BARCODE TYPE
Use this to select the type of barcode. A list of available barcodes in SpeedMark can be found in chapter "Barcode 2D
list".

BARCODE
Use this to enter the barcode applicable for the barcode type.

SIZE
The possible barcode sizes depend on the chosen barcode type and can be setup here.

INVERT
The Invert checkbox is used to indicate whether a barcode should be displayed inverted and which quiet zone settings
should be used.

ADVANCED SETTINGS
Special settings depending on the chosen barcode type can be setup here.
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Variable cell size
The advanced setting of a Barcode offers the possibility to adjust the
size of the barcode cells in X and Y (these are the information dots/lines
that form the barcode). Tuning of this setting is useful when engraving
plastics to get perfect results. Furthermore, it minimizes bulging effects
when deep engraving metal
Additionally, shrinking the cells will speed up the marking process
(smaller cells are faster done), while readability of the barcode persists
(this has to be tested and tuned for the optimal trade off).

QR-Code with cell size
100%

QR-Code with cell size
50%

CELL TYPE
The cell type can be changed from rectangular to elliptical. This will
display all cells of the 2D barcode as ellipses.

DataMatrix with
elliptical cells

CODING OF SPECIAL CHARACTERS
To encode special characters inside the 2D barcode the option "Translate escape sequences" must be enabled. The
special character is defined as "\xhh" inside the 2D barcode text string. The sequence "\x" activates the option and "hh"
stands for a hexadecimal value.

Example: To add a Group Separator (GS) inside a GS1 barcode "\x1D" must be entered which is ASCII value 29.
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5.2.9 Vector Graphic (DXF, PDF)

The Vector Graphic element is used to import vector graphics from external programs (e.g., Corel Draw , AutoCad, …) →
the import of Corel Draw files is limited to to version X3.

As an additional format PDF4 can be used to import vector graphics → Please refer to Appendix: "PDF-Import" for
prerequisites and restrictions.

Inserting a vector graphic opens the “New
Graphic” dialog in which it is possible to
specify the various import parameters. It
is also possible to retrospectively update
the file in the Graphic Properties window.

Information
The imported vector file is then actually embedded in the SpeedMark program. This means that any
changes made to the original file are not automatically applied to the data in SpeedMark. This is only
possible by carrying out a manual adjustment in the Graphic Properties.

SOURCE (NEW GRAPHIC)
A vector graphic is usually imported by entering a file name (including the full file path) or by pressing the button with
the three dots to open a file selection dialog.
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The following vector graphic import filters are available in SpeedMark:

• AutoCAD DWG
• AutoCAD DXF
• HPGL/2
• SVG
• CGM
• Corel Draw (Corel Draw must be installed on the computer to import Corel Draw files) → If Corel Draw is not

installed on the computer, you may export files from Corel Draw as .dxf files and then import them into SpeedMark.
• PDF

In dynamic programs, vector files are sometimes loaded based
on various parameters. The arrow buttons may be used to create
a vector file directly in the front end. → Using Graphic Properties
Source is described in Chapter "Source".

IMPORT POSITION
Use this section to specify whether the original position of the graphic should be accepted or if a new graphic position is
required.

When accepting the graphic position, the graphic’s position data is extracted from the source file and used for the
positioning in SpeedMark. In many cases, this can lead to the graphic being invisible if it is located far outside the
operating range of the laser.

When creating a new graphic position, it is possible to specify both the insertion position and the alignment in relation
to the insertion position using the position selector target.

OPTIMIZATIONS
Use this to activate various SpeedMark import optimisations.

Minimal Vector length

This optimisation is mainly used to reduce the number of points on a curve with many individual points. The minimal
vector length defines the minimum length of a linear vector. The advantage of using this optimisation is the lower
amount of memory required and reduced amount of time needed to import the file. In many cases, the import time can
be cut from minutes to seconds.

Optimise graphic

If this is selected, SpeedMark optimises the graphic for laser processing:

• Deletes zero vectors (unnecessary delay times)
• Links lines to vector strokes if there are no intervals between the existing individual vectors (reduces unnecessary

delay times)
• Implements vector sequencing (flow optimisation)

PLOTTER STEPS
This setting is relevant to the import of HPLG files. It is used to specify the plotter steps required for importing (default
value is 1016).
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The option "All layers" imports all vector
information in one graphic element. By the
option "new graphic element for each layer"
the layers can be imported in separated graphic
elements if the graphic file supports layer
information. The layer names or layer colors are
used to link the new graphic elements to the
material parameters in the material database.

5.2.10 Raster graphic (BMP)

The raster graphic element is used to import raster graphics from external programs (e.g., Paint, Adobe Photoshop, …).
SpeedMark supports a variety of different import filters for transferring data.

Inserting a raster graphic opens the “New
Graphic” dialog in which it is possible to specify
the file name of the graphic and the import
position (centre). Graphic Properties can be
used to retrospectively adjust the raster graphic
settings in terms of pixel density, contrast,
brightness, dithering and execution mode.
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SOURCE (NEW GRAPHIC)
A raster graphic is usually imported by entering a file name (including the full file path) or by pressing the button with the
three dots to open a file selection dialog.

The following raster graphic import filters are available in SpeedMark:

• Bitmap (bmp)
• JPEG (jpg, jepg)

SETTINGS (GRAPHIC PROPERTIES)
Use this to adjust the main raster graphic settings to optimise them for laser marking.

Dot Density

Use this to specify the pixel density in “dots per inch”.

Contrast and Brightness

Use this to align the contrast and brightness of the imported raster graphic to those of the laser marking.

Dithering

This is used to describe the process of simulating colours using a reduced colour palette (e.g., converting a colour
picture to a black/white graphic).

The following dithering algorithms are available in SpeedMark:

• Next colour
• Floyd Steinberg
• Stucki
• Siera
• Jarvin, Judice & Ninke
• Stevenson & Arche
• Burkes

Ordered dithering

To mark images with a laser, it is necessary to convert them to black and white. This conversion uses algorithms to
calculate the result, so depending on the used one, the final image looks different. Till now solely error-diffusion
algorithms were used in Speedmark, as the produce the best visual output. For some applications (e.g., print media)
these fine dots do not provide satisfying result. This also applies to some laser applications.

Because of this SpeedMark also provides the following ordered dithering algorithms:

• Bayer 4x4
• Bayer 8x8
• Bayer 16x16
• Ordered dot 6x6
• Ordered dot 8x8
• Ordered dot 16x16

Clustered dot dithering compared to a error diffusion dithering algorithm (Stucki)
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Additionally, exists a Treshold conversion (like "nearest colour"), that can be
parametrized by the user.

Execution mode

The execution mode determines if a graphic will be marked row by row or vectorized.

The following options are available:

• Photo (greyscale) Graphic will be marked row by row (recommended for photos) with a constant speed.
• Logo fast (Black/White) Graphic will be vectorized and the found regions will be quickly marked with vectors

(recommended for logos). In areas with no marking, the laser quickly jumps to the next vector. The vectors are
sorted to reduce jump sizes.

• Logo slow (Black/White) Graphic will be vectorized and the found regions will be quickly marked with vectors
(recommended for logos). In areas with no marking, the laser quickly jumps to the next vector. Vectors are not
sorted.

Inverted

This specifies whether a raster graphic should be inverted or not.

ADVANCED SETTINGS
For some applications, especially annealing in focus length or black marking
of aluminium, it is necessary to limit the fill distance to a few micrometers.
For vector graphics, this value can be easily set in the fill settings. To get
the same effect for raster graphics, a pixel density up to 25,000 DPI would
be necessary. The subpixel mode automatically increases the pixel density
without consuming system resources. For example, to mark a 600 DPI bitmap
with 25,000 DPI, a subpixel value of 42 must be entered.
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5.2.11 Import

Import Graphic Element supports the import of PDF and EPS files used for raster graphic elements (this means that –
contrary to the DXF/PDF-Import - the vector information is treated as a bitmap and bitmap functions will be used for
engraving).

A file selection dialog is used to select the file
for importing and the appropriate data filter.

Use the Import Graphic Wizard to set the
necessary import settings such as Import
DPI, Page and Import Position (Centre). The
imported graphic element is then available in
SpeedMark as a raster graphic. All raster graphic
settings can be found in the Chapter "Raster
Graphics".
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5.3 Grouping elements

SpeedMark provides two ways of grouping elements that have different
effects. Both will be described in the following chapters. Creation of the
grouping can either be done via the context menu of the drawing area or the
one of the flow charts.

GROUP
A group acts like a permanent multiselecting that can be saved, reselected, and altered. It will be represented as an own
image in the flowchart. There is no restriction, which elements may be added to a group – they may contain graphic
elements along with e.g., control elements.

To create a group, first select the elements that should form the group. This can either be
done on the drawing area or in the flowchart. At least two elements must be selected to
enable the grouping. Right-clicking on the selection will bring up the context menu like
depicted above. By clicking "Group" the group will be created. Changes to properties of
a group will be delegated to each single element in the group (if the element support the
affected one). Because of that those changes will persist even if the group is dissolved
later.

Information
Because a group can contain any type of elements, dynamic transformation cannot be executed on a
grouping element.

COMBINATION
The combination is used to combine the filling of the elements. That means that overlapping areas will be le out. Like
a group the combination can also be saved and reselected and altered and will be added as an own element in the
flowchart. Because of the nature of the combination only fillable elements can be added. Any other element type will
produce an error message that will describe the erroneous entry.
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Like the group the combination is created by selecting at least two fillable elements
and selecting the "Combine" action in the context menu. This can be done on the
drawing area or in the flowchart. On creation the filling of all contained elements
will be discarded. Because of that all elements will appear unfilled. By assigning a
new filling to the combination the desired one will be created.

The combination joins together the contour of all contained elements. The elements themselves are le untouched. Any
changes to the combination will not be propagated to the contained elements. Because of the elements will revert to
their original settings as soon as they are excluded from the combination. The only exception is the filling that will be
discarded.

Information
As the combination is treated as a pure graphic element, also dynamic transformation can be executed on
it.

MODIFYING GROUPED ELEMENTS
To modify elements inside a group or combination either select them directly in the flow chart or via dragging a
selection in the drawing canvas. Clicking a single element on the canvas is not possible as it will always select the full
grouping element. Modifying the element can be done in the usual ways (transformation, properties, or mouse).

Information
Elements in a grouping will keep the changes until they are overwritten by the group settings. The
combination will revert the changes immediately (if the properties are relevant for itself (e.g., filling,
distance, etc.).

RESTRICTIONS
The mixing of grouping, combination, and special elements (Array, deep engraving) has certain restrictions. The
program will give an according error message if an illegal combination is present. The following table will just give a
short overview.

Element  \ Target Grouping Combination Array Deep engraving

Graphic
element

√ Only fillable √ √

Scripting/
Control

√ × × ×
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Grouping √ May only contain graphic
elements
(Non fillable elements will be
accepted and marked in the
usual way, but not integrated
in the combination.)

May only
contain
graphic

elements

May only contain graphic elements

Combination √ √ √ √

Array √ × √ ×

Deep
engraving

√ × × Results will be difficult to predict!
Inner fillings will not be rotated
Solution:
Move the inner deep engraving to a
grouping and add the grouping to
the outer deep engraving.

5.4 Editing Basic Graphic Properties

The Graphic Properties window not only offers the possibility of editing
special graphic element properties, but it also provides the option of
adjusting the basic parameters of all elements. As not all properties are
available for each graphic element, these are greyed out or deactivated, as
necessary.

Auto data apply

If data is changed in the graphic property sheets, they will be automatically applied on leaving the input field (e.g., Tab)
or by pressing “Enter”.

GENERAL
The Graphic Properties General tab contains all the basic setting of each of the individual graphic elements.
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Description section
The standard title is displayed in bold in the flow chart directly next
to the element symbol. It is also possible to add a comment. This is
likewise displayed on the flow chart below the title.
Behaviour section
It determines the process flow of the graphic element. Breakpoint is
used to specify whether the flow should be interrupted during debug
mode or not.
Show graphic is used to specify whether an element is displayed on the
drawing interface or not (please note, however, that this does not affect
the laser marking).
Element active displays the element on the drawing interface although
it will not be marked by the laser unless it is actively set.
Position locked indicates whether the element can be selected on the
drawing area and thus moved/edited.
Marking time section
Shows the calculated time for a graphic element. This is only an
estimation value and will differ, especially for bitmaps, from the
marking time.
Contour and Filling sections (is only displayed for graphic elements
containing filling)
Provide basic information regarding the graphic element in terms of the
number of points, number of jumps and overall vector length.

5.4.1 Filling

The Graphic Properties Filling tab contains all the parameters required to define the filling of a graphic element. → This
tab is only available for shadable graphic elements.

LIMIT PREVIEW FILL LINES IN CANVAS
Filling Style is used to determine the basic type of filling. There are four filling styles available:
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None Filling is deactivated

Parallel lines Filling lines are marked from le to right

Bi-directional Filling lines are marked from le to right
and right to le

Crossed lines
(parallel or bi-
directional)

The filling resembles a definable grid

The Filling Parameters section is used to define the actual
characteristics of the selected filling style in greater detail.

Line spacing Intervals between the filling lines

Angle Angle of the filling lines

Cross Angle Angle of the crossed lines for the hatched
filling style

Closed Polygon This option refers to the graphics with
open polygons e.g., if a “C” in a text
should be shaded, this option forms a
virtual closure between the start and end
points of the “C” so it may be shaded.

With Contour Draws the contour of the underlying
element

Optimize Filling The filling lines are subjected to vector
sequencing and flow optimisation

Filling Angle Relative
to Object Rotation

The filling angle is calculated according
to the sum of the actual object rotation
and the filling angle

Actual Object
Rotation

Displays the actual object rotation.
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LIMIT PREVIEW FILL LINES IN CANVAS

For some applications - especially annealing in focus, creation
of colors on stainless steel or black marking of anodized
aluminum - it is necessary to use fill distances in the range of a
few micrometers (0,001 – 0,005 mm). All these fill lines must then
be calculated and displayed. To improve the performance of
the SpeedMark application, the drawing of the fill lines can be
limited. The maximum value can be defined in the default filling
properties (in the settings menu).

A small warning sign in the properties dialog signals the user that
only a limited number of fill lines is shown.
The marking process is not affected by this setting as it will always
be executed with the real value.

CONTOUR DISTANCE
The filling lines may be shortened by the value entered in the Contour distance section.

Information
However, this function refers to the reduction of
individual filling lines and not the outline itself.
Because of this, it is not a real 2D-contour (which
would be same space at every point between the
graphics and the filling lines), instead a 1D in the
direction of the filling lines.
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Example that shows contour lines shortened by
0,1mm (from 0mm)

5.4.2 Cleaning

Cleaning offers the possibility to process a graphic's area again with different marking parameters (e.g., to remove dust
from the engraving area or to polish the surface).

You can set both the marking parameter set and the special cleaning style.

Cleaning styles

• Content: same area as the marked graphic

• Surrounding: whole area of the graphic
(bounding rectangle) minus the marked region

• Both: whole area of the graphic (bounding
rectangle)

Usually cleaning uses the same settings as the linked
filling, but sometimes this does not yield optimal
results. It is possible to use an independent set of
parameters that can be defined in the advanced
settings (e.g., fill style, line distance, etc.). Additionally,
the cleaning area can be extended via the cleaning
border size (if necessary).
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RADIAL TEXT
Usually, the cleaning area is defined by the bounding rectangle of the graphic (plus the cleaning border size). For the
radial text, this area is restricted to the segment surrounding the text (the bound segment), as it can be seen in the
screenshots above. This leaves out the circle to which the text is aligned.

5.4.3 Line width

BACKGROUND

The line width produced by the laser beam for linear movements of the scanner is determined by 2 factors:

• size of the laser spot (this depends mainly on the wavelength of the laser and the focal length of the lens)
• interaction of the laser with the material

Due to these purely physical and optical factors, it has not been possible to take influence on the line width by the
soware. The line width option allows you to change the width of lines for a laser marking. This option affects all vectors
of the vector graphic (contour, filling, cleaning).

WOBBLE
When wobbling, the linear motion of the scanner is combined with a circular motion. The laser beam is moved spirally.
Through the superposition of circular motions, the line width is enlarged. The parameter line width is the requested
diameter of the circular movement. The parameter "Frequency" represents the speed of the oscillation.

Information
The wobble process depends on the marking speed, the line width and the wobble frequency. An
increasing of the marking speed stretches the spiral movement.

Increasing of the marking speed →
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Information
An increasing of the wobble frequency compresses the spiral movement. If the wobble frequency is too
high the requested line width cannot be reached. The diameter is reducing. This is due to the high speed
of the wobbling. The scanners did not reach the specified positions, due to inertia. This behaviour is
independent from the marking speed. A reduction of the marking speed compresses the narrow spiral
motion only.

Increasing of the wobble frequency →

Notice
By the superposition of linear vector movement
with oscillating circular motion the entire path
that the laser must travel increases significantly!
To generate clean and consistently filled lines with
the Wobble function the marking speed must be
reduced significantly regardless of the material.
Values in the range 25-300 mm/s are useful here.

If wobble is activated the lines will be shown in the
resulting width on the drawing area. This way it is
easy to check if the graphics will look as intended.

5.4.4 Transformation

The Graphic Properties Transformation tab contains all the parameters required to transform a graphic element.
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Anchor point
Defines the fixed point around which the transformation should occur. This point is
marked in purple in the selection marker → see Editing Graphic Elements with the
Mous.
Position
May be adjusted by entering the appropriate values in the X and Y input fields.
Adjusting size
By editing the values in the Height and Width input fields. Activating the
Proportional option retains the aspect ratio of the graphic element.
Object Rotation
May be adjusted by entering an appropriate angle. Negative angles may also be
entered.
Dynamic Transformation
Is used in conjunction with dynamic programs and is explained in greater detail in
the following chapters.

5.4.5 Marking

The Graphic Properties Marking tab is used to edit the necessary material parameters.

A detailed explanation of the marking parameters → see "Material Parameter
Manager".
section intensity
Is used to adjust laser settings like power and frequency without overwriting
the material parameter settings.
Parameter settings
Shows the current parameters used for this graphic element.

Information
Changing the material parameter itself can be done with the
button in section material parameter.
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5.4.6 Source

The Source settings are used to link dynamic data to graphic
elements. For example, it is possible to set series text functions .
→ see "Serial data and Dynamic Graphic Element Content".
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6 Marking with the laser

6.1 Creating a test program

All following procedures are based on the simple program containing the Trotec text pictured above.

To create the programme:

1. Open a new program using the File → New → New Project menu.
2. Select the Outline Text symbol and insert the text in the machining area.
3. Enter a text and suitable font size.
4. Position the text centrally with in the operating range of the laser (represented by the rectangle surrounding the

Trotec text).
5. Save the program using the File → "Save As menu".

✓ The new program is now ready for processing the workpiece.

6. Prepare a suitable workpiece for marking.
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6.2 Border marking

Border marking gives the possibility to mark the graphics with the pilot laser to bring the
work piece to the correct position.

Border marking
The outer bound of all graphics will be highlighted.
Border mark selected graphics
Only the outer bound of all selected graphics will be highlighted.
Border mark positioning graphics
The contour of all available positioning graphics will be highlighted. If the
graphic has a complex outline, the laser may be too slow to produce good
results.

   
Activate the dialogue "Border marking".

   
Border marking
You can change between the above-mentioned options.
Positioning and resize
You can adjust the graphic elements to the work piece.

Information
When option “Selected” is active, changes in position and size
are only applied on these graphic elements.

Execute
All graphics will be marked directly.
Stop
The border marking ends.

RADIAL TEXT AND SIMPLE GRAPHICS
To be able to easily position radial text, those elements are handled differently.
Not a rectangular outline will be shown, but instead the boundary of the text (bent
segment). If a graphic is simple enough (number of vectors, jumps, etc.) also its real
outline is drawn (e.g., single characters). If these limits are exceeded, the resulting
border mark would be badly visible. So, the system will switch back to using the
bounding rectangle.

77



Marking with the laser

6.3 Normal program execution

This function is used to execute an entire SpeedMark program including the
program and control elements.

START PROGRAM EXECUTION AND MARKING
The actual program execution is started either using the menu (Start → Execute) or the F12 function key.

END PROGRAM
When the program execution starts, the “Execute Program” window
opens. The program execution can be stopped at any time by pressing
the Stop Marking button. When the program is complete, the execution is
automatically interrupted. The window can be closed by clicking on the close
button top right.

6.4 Quick mark

This function is used to execute programs simply and quickly in SpeedMark.
Its main purpose is the simple set-up of the work piece and retrieval of the
relevant marking parameters. It is initiated using either the menu (Start →
Quick mark) or the F8 function key.

   
Information
The Quick mark function is only used to perform the marking of
graphic elements. This mode is not used to mark program and
control elements and will ignore any movement actions by a
deep engraving element.
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6.4.1 Setting up the workpiece

The “Border Marking” and “Border mark positioning graphics” functions are
used to set up the work piece in the machining area.
The “Border Mark” function enables the XY set-up of the work piece. The pilot
laser is used to draw the smallest possible rectangle for all created graphics.
With the function “Border mark positioning graphics” only such elements with
the material parameter property “Positioning” will be drawn with a rectangle
by the pilot laser → see "Material Parameter Manager".

Caution
While the pilot laser is drawing the rectangle, it is in principle safe to reposition and set up the work piece.
However, you must continue to observe all laser safety guidelines.

The pilot laser may be deactivated once the work piece has been set up by pressing the button again.

6.4.2 Marking in quickmark mode

Use the Start Marking button to start the laser marking the workpiece.

Warning Laser
Use the Stop marking button to interrupt the current marking
process at any time.

 
The “Repeat” option causes SpeedMark to repeat the marking until the Stop Marking button is pressed. You can specify
the pauses between the individual repetitions.

6.4.3 Power

The currently defined material parameter settings can here slightly be
adjusted (power and marking speed).
The button “Apply to project” will take over these adjustments to the
single graphic elements.
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6.4.4 Options

Only selected graphics
Will only mark currently selected graphics in the drawing interface.
Mark inactive graphics
Allows the marking of inactive graphics.
Trigger on MarkStart signal
Causes SpeedMark to begin marking only once the MarkStart signal is
issued.
Exhaust on
Will start a connected exhaust before marking.

6.4.5 Marking information

Once the marking is complete, all relevant information such as the
number of marked objects, number of cycles, marked vectors, cycle
time and marking time are displayed.
The cycle time indicates the total marking time including the
calculation of the vectors and transfer of the data to the laser system.
The marking time indicates the time the laser required to complete the
actual marking.

6.5 Individual zero offset

To improve the designing of marking in SpeedMark, the zero point of the
marking area can be moved. This makes working with trays much easier, as it
allows the drawing area to be adapted to the environment.
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This option is also available for segmentation. It shows the current zero point
of the mechanical axes of the SpeedMarker system and can also be freely
changed.
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7 Material parameter manager

Material parameters can be used to adjust how the laser marks the workpiece. This chapter describes how the material
parameters are defined and how they can then be applied to individual graphic elements.

In SpeedMark there is the difference between global material database und local project material parameter:

• The global material database is available for all projects. A change will affect all projects.

• The local project material parameter will only be saved with single projects. A change will affect only this project.
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7.1 Manage global material database

The global material database is available for all SpeedMark projects and allows the controlling of materials and the
associated material parameters.
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All used material parameters can be managed by the material parameter manager.
If not already visible, this dialog can be opened using the View → "Global material
database menu" or the marked buttons in the picture above. All materials and the
groups are presented in a tree structure for a better overview.

   
Materials and the according groups can be added, edited, or deleted with a context
menu (right mouse button).

Notice
The material “Standard” cannot be deleted.

7.2 Manage local project material parameter

The local project material parameters are only available for one specific project.
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All used material parameters can be managed by the material parameter
manager. If not already visible, this dialog can be opened using the View
→Project material parameter menu or the marked buttons in the picture
before.
All materials and the groups are presented in a tree structure for a better
overview.
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With the button “Take over materials” it is possible to copy materials from the
global material database to the project material parameters.

   
Materials and the according groups can be added, edited, or deleted with a
context menu (right mouse button).

Information
The material “Standard” cannot be deleted.

Additionally, it is possible to copy project materials to the global database.
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7.3 Define material parameters

A material parameter set always consists of 16 parameters with a name and an allocated colour. This colour is also the
colour used to represent the graphic elements in the drawing interface.

The material parameters may be defined according to the following settings:

• Aktiv, Name - specifies name and state
• Marking mode - defines special executions modes
• Laser system parameters - specifies the laser output, marking speed and frequency
• Quality - this is used to specify any laser marking delay values
• Advanced - specifies advanced settings e.g., repetitions

7.3.1 Active, Name

Defines if a material parameter is active or not. Inactive material parameters cannot be chosen for graphic elements. The
name of a material parameter can be chosen individually.
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7.3.2 Marking mode

The marking mode defines special execution settings for this material parameter.

Marking
The graphic element will be marked with the specified laser system parameters.
BMP Auto Speed
Die Vorschubgeschwindigkeit der Scanner wird automatisch aus der DPI der
Rastergrafik und der eingestellten Laserfrequenz errechnet. Somit ist in diesem
Modus eine Anpassung der Geschwindigkeit nicht möglich.
Registration marks
The graphic element will NOT be marked with the laser but serves only to set up via
a camera system (For details regarding the camera please consult the additional
manual "SpeedMark Vision").
Positioning
The graphic element will NOT be marked with the laser. It will only be used for
positioning of the work piece → see "Setting up the Workpiece".

7.3.3 Laser system parameters

Laser output can be defined in per cent for the purposes of laser processing. The minimum value is 0 per cent and the
maximum value 100 per cent.

Information
Depending on the laser system used, it may be that certain types of laser only produce an actual laser
output above a certain threshold value (e.g., 20%). Please refer to the relevant values in the user manual
specific to your laser system.

The Marking Speed parameter affect the behaviour of the scanner head used by your laser system. The Marking Speed
specifies how fast the scanner head moves during a laser marking process.

In addition to the output, it is also possible to specify the frequency of the laser pulses. The minimum and maximum
values are therefore limited by the type of laser system used. → Values normally range between 20 kHz and 80 kHz; new
lasers offer ranges between 2-200kHz.
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7.3.4 Quality - Delay parameters

With the parameter quality it is easily possible to configure the delay
parameters of the laser system. →
(Some of these descriptions have been extracted from the documentation
regarding your TLC2 card. Additional information regarding the delay
parameters can be found in the documentation belonging to your TLC2 card
or the control card you are using.)
A value of 100 means a high quality with moderate delay values. A value to
0 increases the execution speed of a graphic element but can cause quality
reduction on certain materials. Because only certain delays influence the
marking speed (Marking & positioning), only these are affected by the slider.

   

Additionally, to the quality parameter it is possible to setup the delay values manually by activating the checkbox
“Setup delays manually”. As a laser system essentially consists of two components - the laser and the scanner head -
the dynamic behaviour of the scanner head must be synchronised appropriately → A time delay results from the initial
acceleration of the mirrors at the beginning of a movement.

The following laser and scanner delays are available:

• Positioning speed
• Marking delay
• Positioning delay
• Polygon delay
• Laser On delay
• Laser Off delay

Positioning speed The Positioning Speed specifies how fast the scanner head moves between two
markings.

Scanner delays
Scanner delays determine the behaviour of the scanner head in relation to the movement of the mirrors.
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Marking Delay Although the marking speed is normally lower than the jump speed, a drag delay
will occur during marking. To ensure that the mirrors have arrived at their target
position before the marking process begins, a suitable value may be selected for
the marking delay.

Positioning Delay At the beginning of a jump between two vectors, the mirrors must first be sped
up to reach the preset positioning speed creating a time delay (also known as a
drag delay) which must be compensated for. In addition to the drag delay, another
delay occurs at the end of the jump as the mirrors must be brought to a complete
halt. Their slow reaction time causes a certain amount of oscillation around the
target point (settling time). A suitably high positioning delay must be selected to
account for the drag delay and settling time.

Polygon Delay It is not always necessary to completely stop the movement of the mirrors
between two consecutive vectors (e.g., the corners of a rectangle). At this point,
instead of a marking delay, a polygon delay is automatically inserted as the drag
delay and settling time are less.

Laser Delays
The laser delays determine when the laser is switched on or off before or aer a marking (e.g., vector stroke). The laser
delays do not affect the overall marking time unless negative values are selected.

Laser on Delay The laser on delay specifies how long the laser must wait before being switched
on, although the scanner head has already started the marking process.

The laser on delay may be used for the following purposes:

• To prevent a burning effect at the start of a marking process as the scanner
head must bring the mirrors up to the preset marking speed. A suitably high
positive value should be selected → However, if too high a value is selected,
the first part of the vector will not be marked.

• Some materials take a certain amount of time to react to the laser beam. It
may therefore be worthwhile pre-heating the start point of the vector before
marking begins. This can be achieved by selecting a negative value → Using
negative values for the laser on delay extends the overall marking time.

Laser Off Delay The acceleration phase at the beginning of a scanner head movement creates a
difference between the respective target and actual positions of the mirrors. As the
laser should not then be switched off again when the target position is reached,
but when the actual position is reached, it is possible to enter a laser off delay.

PROJECT DELAY VALUE GUIDELINES

Information
These guidelines apply primarily to the use of a TLC2 control card. Please refer to the relevant guidelines
in the documentation of any other control card you may be using.

When setting the delay values, ensure that the following guidelines are observed to avoid problems:

• The laser off delay must be longer than the laser on delay. Otherwise, laser control errors may occur. →LOffD >
LOnD

• The marking delay must be greater than the difference between the laser off delay and the laser on delay. → MarkD
> LOffD – LOnD
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7.3.5 Advanced

In the advanced pop-up properties iteration can be configured.
By defining a Z-Offset the Z-axis is moved automatically by this value during
marking (of an element that uses that material parameter) . Aer marking the Z-axis
is moved back to the starting position (the value before the Z offset was added). This
Offset defines a relative movement (not an absolute position) for the axis.

Notice
To be able to use this feature an automatically controlled Z-axis must
be installed. Otherwise, the soware cannot make the necessary
adjustments.

Z-OFFSET FACTOR
The Z-Offset factor is used to compensate any deviations from the intended size that are a result of the movement of
the Z-axis. E.g., moving the Z-axis down, shrinks the working area and the contained elements. The factor is only used
if the Z-Offset is other than 0. This offset factor cannot be calculated automatically because there are many parameters
that must be regarded (original size, layout in the marking area, system configuration, etc.). So, the ideal value must be
determined via tests. Be aware: values > 1 increase the final size, values < 1 decrease the final size.

The following examples should visualize
the influence of the parameters.
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A negative Z-Offset moves the axis
down, which shrinks the working area
(and the contained elements). To
compensate this, a positive offset factor
must be defined.
A positive Z-Offset moves the axis up,
which enlarges the working area (and the
contained elements). To compensate this,
a negative offset factor must be defined.

   
Notice
Any scaling is done based on the centre of the working area! Because of that the Z-offset factor also
"scales" the centre point of the graphics element (which subsequently influences the final position of the
element).

If the system has a MOPA laser source the pulse duration and prepump can be configured. The pulse duration specifies
the timing length of a laser pulse. The prepump value increases/reduces the laser energy on start of a vector.

7.4 Ordering entries of the material database

The material database offers the possibility to rearrange the
groups and material entries. This can be done in the global as
well as in the project database. The easiest way is reordering
the entries via drag and drop (mouse), alternatively the reorder
buttons on the right side of the tree can be used. Those buttons
will be active if a valid move of the selected element can be done.

Notice
Sometimes the mouse cursor has to be moved to the side of the desired drop target, otherwise the drop
would try to create a sub element that is not possible. By trying out the different drop positions you will
get used to the drag and drop behaviour quite fast.
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7.4.1 Restrictions

Not all drop targets are valid for certain elements. This will be shown either by an according "not allowed" cursor during
drag and drop or the move buttons will get disabled (will turn grey).

The following actions are not possible:

• Entries that originally belong to the default group (standard) can't be moved outside of this group. Materials that
have later been placed into the standard group can of course be moved out again.

• Group in another group (no nesting)
• Placing a material outside of a group

7.4.2 Alphabetic sorting

Additionally, it is possible to sort the material groups and
materials ascending and descending by name. This feature is
available through the options menu.

7.5 Exporting material parameters

With the export option it is possible to write the whole material
database into a CSV file . → These files can be opened with a text editor
or Microso Excel and similar programs.

7.6 Applying material parameters to graphic elements

Graphic element material parameters can be set in Graphic Properties and via the “Material Parameters” toolbar.
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7.6.1 Setting material parameters using graphic properties

The Marking tab in Graphic Properties can be used to directly
apply the material parameters to the graphic element using the
material parameter combo boxes.

7.6.2 Setting material parameters using the toolbar

By using the “Parameter” combo box it is
possible to directly set the material parameters
of all selected graphic elements.

The selected parameter is also automatically allocated to any
newly inserted graphic elements. The material parameter
manager is easily opened using the marker symbol on the right-
hand side.

7.7 Determine ideal material parameters

SpeedMark offers various possibilities to tweak parameters to influence the engraving result. Because of that it is
difficult and time consuming to test all combinations.

The following settings are the most important to control the engraving quality:

• Frequency (frequency of the pulses the laser fires)
• Marking speed
• Power (% of the maximum power the laser offers)

Information
Techniques like moving the focus plane or tuning of the quality parameters are not regarded in this
chapter!

To aid in the finding of the perfect material parameters, SpeedMarks offers Templates that will test the various
combinations. These resulting test matrices can be engraved in any size (depending on the working piece). The best
material parameters can be easily determined by comparing the results.
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These templates can be found in "File" → "New" →
"New program from template".

The files for the material parameters are located
in the folder "MarkingParameter". There are
two sorts of templates: one with fixed values
and the others with dynamic value ranges.
The first type can be found in the subdirectory
"constant values", the dynamic ones in the
directory depicted below. Constant matrices
offer a better execution time and can be resized
quite simple. Therefore they are very useful for
a first and quick impression. Finetuning the
parameters can then be done with the dynamic
ones.

To do a dynamic parameter finding, simply open the according template and execute the program. It will guide you
through the necessary steps (values, bordermarking, etc.). There are three types of constant templates that will be
described in the following chapters.

7.7.1 Fixed power

The values for frequency and marking speed are varied in a
predefined range.
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The value in this template type filename depicts the fixed power
value (in %).

7.7.2 Fixed marking speed

The values for frequency and power are varied in a predefined
range..

   
The value in this template type filename depicts the fixed marking
speed value (in mm/s).
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7.7.3 Fixed frequency

The values for marking speed and power are varied in a
predefined range.

   
The value in this template type filename depicts the fixed
frequency value (in kHz).
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8 Desktops and user rights control

In SpeedMark it is possible to adjust the user interface to your personal requirements by moving, opening, and closing
individual windows (docking). Using the SpeedMark desktop it is possible to save the thus configured user interfaces
and open them later for use in other applications.

8.1 Initial user rights

By default, SpeedMark is shipped with limited user rights to avoid accidental changes of the configuration .

Information
When upgrading from a previous SpeedMark version this presetting may be differ. In this case contact your
system administrator.
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Caution
SpeedMark is configured with an initial administrator password. Please change this password to protect
your system from unauthorized access.

To change the user rights and the existing passwords a change to the administrator user is necessary:

• Menu → Tools → Switch user
• User: Administrator
• Password: admin

Aer this user switch all actions described in the following chapters can be performed.

All predefined users:

User Passwort Kommentar

Administrator admin has all system rights

User user is permitted to use all laser functions

Operator operator can execute laser jobs

8.2 Adjusting the SpeedMark user interface layout

OPEN AND CLOSE WINDOWS
SpeedMark windows can be opened and closed using the View menu. Open windows are indicated by the tick on the
le-hand side of the menu item.

It is also possible to close a window directly on the user interface by clicking
on the X next to the window title.

DOCKING AND MOVING WINDOWS
All open windows can be moved by clicking with the mouse directly on the window title in the user interface. These
windows can be moved freely around the user interface and docked on the sidebars.

Information
The “Flow Diagram” window is the only window which cannot be moved as it is linked directly to the
drawing interface. However, it is still possible to open and close this window.
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8.3 Managing customised user interfaces using the desktops

The Desktop Manager can be used to save user interface layouts for use in other applications (as described in the
previous chapter).

8.3.1 Creating and selecting desktops using the toolbar

The menu item Tools->Switch desktop can be used to select the standard desktop and previously saved desktops (e.g.,
operator), and to save current desktops.

This menu consists of three parts:

• Standard desktop
• List of previously created desktops
• Save desktop

“Save Desktop” can be used to save the current user interface as a
desktop. The adjacent dialog may be used to assign a name and
description to the created desktop. The desktop is created by pressing
the OK button.
Every newly created desktop is then added to the desktop list and is
available for selection.
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8.3.2 Creating and managing desktops using the desktop manager

Via the menu: Tools → User managements and desktops… it is possible to open the Desktop Management dialog. This
dialog displays all the desktops currently available. The Add button is used to add the current user interface as a new
desktop.

Information
If you want to create a user interface without the Desktop toolbar, you can do this using the Add button. It
is not possible to do this using the Desktop toolbar.

The Delete button can be used to delete existing desktops.

8.4 SpeedMark windows

All SpeedMark windows can be opened and closed using the menu items on the View main menu.

Project management
The Project Management window lists the master program and assigned sub-
programs. The second column displays the file paths.
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Graphic properties
The Graphic Properties window displays all the data relating to a selected
graphic element. It may also be used to adjust all the relevant properties.

Flow chart
The Flow Diagram window displays the entire program flow. It is also possible
to adjust the structure of the flow by inserting elements.

Controlling variables
The Variable Monitoring window displays the values of all the defined
variables during the debugging process (only when pause or breakpoint).

Error messages
Error messages caused by the program are displayed in this window.

Execute program
The Execute Program window executes the current SpeedMark program.

Internal runscreen
Is used to interrupt the current program. It displays the overall flow time when
the program is complete.

Program messages
Über den Programmbefehl „AddProgramMessage“ können Meldungen an
dieses Fenster ausgegeben werden.

Programm log
The “AddProgramMessage” program command can be used to issue program
messages in this window.
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Execution counter
The execution counter shows the current program execution or the value of
the current execution counter element.

Execution info
The execution info shows various information of the current running marking
program.

8.5 User groups

Via the menu: Tools →User Rights and Desktops it is possible to open the User Rights Management dialog.

The user rights control is based on the user groups.
The user groups Administrator, Developer, User and
Operator are provided as standard.
Add Button
Can be used to add new user groups.
Edit Button
Can be used edit existing user groups.
Delete Button
Can be used to delete existing user groups. However,
this is only possible if the user group does not have
any users allocated to it. It is also not possible to
delete the Administrator user group.

It is possible to specify the following user group properties:

• User group name
• User group description
• Desktop

The Desktop option is used to assign existing desktops to the user group.
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Information
If one of the users of this user group now registers with SpeedMark, it automatically switches to this set
desktop.

8.6 Access rights

The Access rights tab is used to define the rights
of individual user groups in detail.
It can be used to specify whether menu items
should be activated or deactivated and whether
menu items should be visible or invisible.

8.7 Users

Users tab
SpeedMark users may be created and edited.
Add button
Adding new users.
Edit button
Existing users can be edited.
Delete button
Existing users can be deleted.

   
Information
However, this is not possible for the final user of the Administrator user group.
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The following properties may be specified for a user:

• Username
• Full name of user
• Password
• Assigned user groups
• User status (active/inactive)

8.8 Basic user rights settings

The basic user rights settings are used to define user control
behaviour in more detail.
Standard user login
Option is used to specify a user registered automatically
when SpeedMark starts.
Password required on login
Option specifies whether a user must enter a password
when registering or not.
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9 Configuring SpeedMark

The basic SpeedMark settings can be opened via the Tools → Settings menu. This dialog can be used to set and adjust
all basic SpeedMark settings.

9.1 General properties

9.1.1 General

The selection of the initial marking parameter can be done
in section material parameter at program start.
Units
Are used to specify whether the SpeedMark interface should
display millimetres or inches. As SpeedMark always saves
and processes all measurements in millimetres it is easy to
perform a conversion during operation.
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9.1.2 Auto-Start

The Auto-Start section is used to specify whether a
SpeedMark program should be loaded and executed
automatically when SpeedMark starts up.
The program name and path may be entered directly
into the editing field or inserted from a file selection
dialog using the “Open file” button (on the right-hand
side of the editing field).

9.1.3 Marking

In the section exhaust the default setting for the exhaust is
defined.

9.1.4 Language

SpeedMark supports two languages as standard: English and
German. To switch languages, the relevant language should be
selected and then the “Standard” button pressed to set it as the
new default language.

Information
As SpeedMark does not allow the language to be switched during operation, SpeedMark must be
rebooted for the change to take effect. Additional languages can be added by pressing the button “Import
language.
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9.1.5 Advanced

The Undo option is used to specify how many undo steps
should be saved in SpeedMark when editing graphic
elements.
However, this history is deleted entirely when SpeedMark is
closed and is not available aer a reboot.
With the button “Reset to factory settings” it is possible to
reset all made changes.

Notice
Please check if all laser specific configuration files are backed up because it is not possible to undo this
operation.

9.2 Default file path

The default file path option allows the definition of
paths which will be used in file open and file save
operations.

 This is possible for the following file types:

• Project files
• Template files
• Vector graphic files
• Raster graphic files
If no file path is defined, the last known path will be
used for this file type.
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9.3 Default properties of graphic elements

The default properties of graphic elements
allow the specification of default values
which will be used when creating new graphic
elements.

  
 This is possible for the following elements

and graphic properties:

• Circle/Arc
• Rectangle
• Text/Outline-Text
• Barcode
• Datamatrix
• Vector graphic
• Raster graphic
• Filling
• Date/Time
• Serial text

9.4 User interface

In the section user interface defaults for the user
interaction with SpeedMark can be defined.
Tab Drawing area
Moving distance defines the amount by which
selected graphic elements should be moved on
the drawing area when cursor keys are used.
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9.5 Laser system configuration

The dialog for configuring the laser system can be
opened with short cut F3 or via the menu Tools
→Laser system configuration.

Information
If this operation is locked by user rights,
change to the administrator level (see
"Initial user rights").
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9.6 System configuration

On the tab system configuration all available
components (like TLC2 Laser controller) can be
registered
These registered components can be used for special
tasks like MarkStart monitoring, controlling the
exhaust and so on.

The following component types are available:

• LaserController - Controls the laser
• RunScreen - Dialog control during program execution
• MarkStart-Eingang - External signal to start marking
• MarkBusy-Ausgang - Sets the marking busy signal
• AutomaticMode-Eingang - Controls the automatic program execution
• X-Axis - Axis for planar segmentation
• Y-Axis 1 - Axis for planar segmentation
• Y-Axis 2 - Axis for planar segmentation
• Z-Axis - Axis for distance to work piece
• A-Axis - Axis for rotary
• B-Axis - Axis for rotary
• Exhaust - Controlling the exhaust from SpeedMark

To register component, they must be defined. This will be described in the following sections of this document.
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9.7 Components

This dialog is used to add new components, modify existing
ones and delete those no longer required. In order to add a
new component, a component name must be entered, and the
appropriate module selected. As SpeedMark features a lot of
components that can be used and configured, the components
are divided into logical groups. This way it is easy to identify the
according group and pick the wanted component from there. Add
a new component by clicking on the plus symbol.

   
Once the components have been added, they can be fully
configured by double-clicking on them see "Modules and
Components".
Components can be deleted by selecting the components then
clicking on the Delete symbol.

9.8 Additional components

This kind of components can be defined additionally to normal
components within SpeedMark.
They are special in that way that they use functional parts of
normal hardware components.

   
With this structure it is possible to connect a single IO-Input like MarkStart with a physical IO-Input of a hardware
component. In most cases that will be the TLC2-card, but it also could be the IO-Input of a Relop-IO-card. Due to this
abstraction within SpeedMark a MarkStart is available and the real origin of the signal can be configured.
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9.8.1 Component type IO-Input

For an IO-Input additional component it is possible to choose an IO-Input
from the combo box IO-Input. The combo box provides all available inputs
from all hardware components.

9.8.2 Component type IO-Output

For an IO-Output additional component it is possible to choose an IO-Output
from the combo box IO-Output. The combo box provides all available outputs
from all hardware components.

9.8.3 Component type exhaust

The configuration of an exhaust allows the definition of the necessary signals
as well as the behaviour during program execution.
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9.9 System profiles

The system profiles offer the possibility to save the whole
configuration of the laser system. This includes all config-
files and components with their individual settings.
Use this feature to quickly change between different system
setups or hardware components (e.g., other lenses).
Mark a saved profile to see the details of the saved system.

Notice
Profiles save the system state now they are created. So, to be of use, the whole system must be configured
to make up a valid and useful profile (laser system, axis, distortion correction, etc.). Otherwise, each step
that was not configured must be done again aer the load of a profile.

Notice
If a new profile is loaded the zero point of any axis (especially Z) might me set to the saved zero point, but
the axis will not be moved that location! This must be done manually at some point before starting to
engrave with the new configuration!

Saved profiles can easily be switched by selecting it in the
menu entry "Tools" →"system profiles".
The last loaded system profile is shown at the end of the
menu. Please note that the current configuration may differ
from this system profile.
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10 Graphic operations

With graphic operations it is possible to change the execution of graphic elements:

• Segmentation
• Deep engraving
• Array

10.1 Segmentation

There are two types of segmentation: The Linear segmentation and the Rotary engraving. In case of a linear
segmentation, the galvo head or the workpiece is moved by a mechanical feed axis. This increases the possible marking
area. In case of a rotary engraving, the marking surface is located on a circumference. The circumference can be marked
by rotating the workpiece.

10.1.1 Setup segmentation

The segmentation can be configured via menu point Project →Segmentation.
First the checkboxes for the X and/or Y direction must be activated, depending on
whether a 1D or 2D segmentation is required.

   

115



Graphic operations

   
The desired axis is selected in the list. The X, A or B axes are available for the X direction. For the Y direction, the Y, A,
or B axis. E.g., the X and Y axes must be selected for a 2D linear segmentation. A combination of two rotary axes is
not possible. In the general settings will be defined which axis will be used for the motion. The available axis must be
configured before usage .
SpeedMark automatically detects if the used axis is a rotation or planar axis .

10.1.2 Managing marking segments

The marking segment list window can be shown via menu point View →
Operator Windows → Marking Segments.

Menu item Symbol Description

Add Adds a new marking segment to list by entering position and size.

Delete Deletes selected marking segment

Edit Edits the properties of the selected marking segment

Add by mouse drawing Adds a new marking segment by drawing a rectangle on the canvas.
This mode is stopped by clicking the icon again.

Copy Adds a copy of the selected marking segment

Start wizard Starts the marking segment creation wizard

Delete all Deletes all marking segments in list

Move up Changes the order of the marking segments

Move down Changes the order of the marking segments
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10.1.3 Adding marking segments

All graphics are divided manually into marking
segments. The marking segments can be created in the
following ways:

• Manually by adding it with  and entering the values
• Manually by using the mouse mode
• Via the wizard

WIZARD
With the help of the creation wizard, an equidistant grid can
be generated over the entire working area. The start point
for the generation of the grid can be shied by adding an
offset.

Wizard generated grid without an offset Wizard generated grid with an offset in X and Y
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Information
The wizard can only be used with an empty marking segment list.

MARKING SEGMENTS
Each marking segment is shown in the canvas and the order is symbolised by a small number.

Selected marking segments (displayed in green) can also be
moved by pressing CTRL+arrow keys on the keyboard.

Each marking segment can be edited aerwards by clicking  .
Additionally, this way an offset for each segment can be defined.
The offset setting of each marking segment shis the moved axis
position during execution. The marking content is not affected.
Smaller (absolute) positioning errors of the axis system can be
corrected that way.
The drawing surface menu can be used to switch both the
numbering and the display of the marking segments themselves
on and off.

10.1.4 Execution of the marking segments

For a segmentation, each marking segment is executed in the order specified.
The axes are moved to the centre of the marking segments. Then the marking
content is executed in the order of the flowchart.

In the example below the axes will move to the first marking segment (number 1). Then the first part of the ellipse and
aerwards the Text 1 is executed, because Text 1 comes aer the ellipse in flowchart. Next the axes move to second
marking segment (number 2). Here Text 2 and then the rest of ellipse will be executed, because Text 2 comes before the
ellipse in flowchart.
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SPECIAL TREATMENTS
All graphic parts that are not contained in a marking segment are ignored. The marking
segments acting like a die cutter. Not cutted parts are ignored without any error message.
A special case are here raster graphics. If a raster graphic completely fits into the marking
segment the graphic is not divided and executed altogether. If not, the raster graphic is
executed line by line. The line feed is performed by the mechanical axes instead of the
galvo.

   
Overlapping parts are only marked in the first segment where they are encountered (list
order) and are removed from the other segments.

If marking segments overlap, the overlap is executed from the first segment in order. The
example shows the resulting segment (number 2).
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10.1.5 Linear segmentation

The size of the marking field results from the travel
distance of the axes (limits) and the size of the
galvo marking field. The grid size values are used
for the marking segment creation wizard. In a 1D
segmentation one dimension of a marking segment
is the galvo size. This behaviour can be disabled by
checking the „always 2D segments” option in the
marking segment manager window. With this option
enabled 2D marking segments can also be created
in a 1D segmentation. By splitting the graphics in
free regions (without overlapping content) the final
segmentation result can be greatly improved.

   
The marking type specifies if the laser head or the
object is being moved by the defined axis.
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10.1.6 Rotary engraving

The size of the marking field results from the diameter
input. The size of the marking segments is limited.
This is done by segment size, segment angle or depth
of field. These three values describe a circular arc and
are interdependent. Changing one value will change
the two other values.

   
The following graphic illustrates this:

• "s" - segment size in mm
• "a" - segment angle in °
• "f" - depth of field of the segment in mm

   
Furthermore, the position of the rotary axis with respect to the marking field must also be defined. The direction of
rotation is changed via the marking type (internal or external marking). The "Autofocus" option moves an existing Z axis
to the focus point depending on the diameter. The entered value matches the Z height of the axis of rotation to which
the workpiece rotates.
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10.1.7 Advanced settings

The advanced settings allow to configure the segmentation better.

The Bitmap Lines per Segment parameter is used to improve the throughput speed. If this value is increased, several
bitmap lines per axes move are marked. The number of axis movements is thereby reduced.

In addition, you can specify how the system should behave at the beginning and at the end of the segmentation. A
movement to the zero point of the axes can improve the result because the segmentation always takes place from the
same origin. With the determination of the sorting, a possible fast axis can be preferred.

10.2 Graphic array

The graphic operation array can be selected from the toolbar graphic
operations .
The graphic operation array can be selected from the toolbar graphic
operations .
Use the array element to mark the same graphic element multiple times in
a rectangular grid. The raster defines the count and the offset of the array
elements.
The execution flow specifies how the elements should be marked. In the
section “Behaviour on serial data” will be defined if the serial function should
be called for every single element of the array or should be called only once
for the whole array.
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On the tab sheet Excludes it is possible to exclude single cells of the array from
being marked.
All cells with a hook will be marked. Cells without a hook won't be marked.
In the drawing area all excluded cells will not be shown as well. An exception
is the cell which contains the original graphics. This cell will be marked with
"Excluded“ if this is the case.

10.3 Deep engraving

 The graphic operation deep engraving is as well selected by the toolbar graphic operations.

The iteration count defines the deepness of the engraving.

In the section filling it is possible to define the rotation angle and when it should be applied. This is important to
optimize the surface quality of the deep engraving (smooth, not rippled).

The option mark contour of the filling settings can be overwritten. Additionally, with the axis control it is possible to
move the z-axis.

10.4 Focus shi

The graphic operation focus shi is selected by the toolbar graphic
operations.
Each level is defined by a Z-offset. Levels can be easily added and
deleted. The levels are processed in the order in which they were
defined.
On execution, the optical axis is moved to the new Z-offset value and
then the elements contained in the level are processed. Execution then
continues with the next level.
This element controls only the optical axis - not the mechanical Z axis.
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In the flowchart, the individual levels are symbolized by paths. Each
path contains the name of the layer as well as the Z-offset. The graphics
can then be added to each path according to the Z-level.
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11 3D Projection

When marking on a 3D object with a 2D laser marker, the following problems occur:

• The marking is not the same everywhere because the laser can only work in focus in a small area (depth of field).
• If the difference in Z-height becomes too great, marking cannot be done (marking disappears).
• The graphics appear geometrically distorted on the object.

With 3D projection, the graphics of the 2D drawing surface are projected onto a 3D object:

• The 2D graphic data is converted into 3D graphic data so that the resulting 3D marking appears on the workpiece
without distortion.

• The Z-focus position is always readjusted so that work is carried out in focus at every location on the 3D object.
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11.1.1 Operating principle

The 2D drawing surface is unrolled onto the 3D object like a sheet of paper. The 2D origin (0,0) corresponds to the green
tag point on the 3D object.

The size, position, content etc. of the 2D graphics on the drawing surface thus have a direct influence on the 3D result.

Changing the 3D tag point (location on the object) only affects the 3D result, not the 2D drawing area.

The graphics always appear in the 3D preview without filling, as these are only calculated for marking.

11.1.2 Requirements

The following requirements must be met:

• A SpeedMarker LWS with XYZ axis system
• A SpeedMarker DS must be installed in the LWS.
• 3D licence key for the SpeedMark soware
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11.1.3 Restrictions

The 3D projection cannot be used together with the following SpeedMark features:

• Segmentation
• Registration mark recognition
• Deep engraving element
• Raster graphic element
• FocusShier element

11.1.4 Activate 3D projection

1. Create your 2D graphics in
SpeedMark as usual.

2. Then click on the menu item "3D
Projection" -> "New 3D Object...".

3. Now select a 3D basic shape.
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4. In the next step, select the type of 3D
object (sphere or hollow sphere in
the example).

5. Now configure the 3D object and
close the dialogue with "OK".

   
You can see the result in the 3D preview. The 3D projection thus affects all the graphics in the current programme, not
the other programmes in the project. This allows you to combine different 3D projections in one SpeedMark project.
Create a sub-programme for each projection and activate the 3D projection mode in it.

11.1.5 Configure 3D projection

Depending on the 3D object type, different
data is required for the creation:

1. To define a point on the 3D object, move
the xyz-axes of the LS to that position.

2. Make sure that the pilot laser and the focus
laser overlap (the laser is then in focus at
this position).

3. To move the xyz-axes, use the menu on the
right.

You can move the axes individually here (arrow
buttons). The current xyz-position is displayed
on the right-hand side.
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 +  + 

Another possibility is the procedure via
keyboard:

1. To do this, press the "Alt" key and the
desired arrow key on the numeric keypad.

2. By pressing the "Alt", "Ctrl" key and arrow
keys on the numeric keypad, the z-axis can
be moved.

3. Then take over the current position by
pressing the button "Take over current axis
position" on the le side.

   
You can return to this position at any time by pressing the "Move to this position" button.
   
   

11.1.6 Import, export 3D object

You can also export your configured 3D object to a file.
This allows it to be reused in other sub-programmes or
SpeedMark projects.
The information of the 3D object is exported into a *.sp3D file.
Only the current 3D configuration is saved in the file - not the 3D
graphic data.

11.1.7 Deactivate 3D projection

By pressing the menu item "Deactivate 3D projection"
you can deactivate the 3D mode in the current
programme or in the entire project (all programmes).

11.1 Projection types

The following projection types are currently supported.

Inclined plane Cylinder
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Ball Hollow cylinder

Hollow sphere

11.1.1 Inclined plane

3 points are needed to configure a plane in
space.
The location of the points also determines the
position of the graphic on the 3D object.
The 2nd and 3rd plane points determine how
the 2D x-direction is mapped onto the 3D
object.

   
These two points must point in the same
direction as the bottom edge of your 3D
marking result.
If these two points are swapped, the graphic is
mirrored on the 3D object.
If the points are not exactly on the lower edge,
there will be a rotation.
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For the first point, select any point on the upper
edge of the marking result.
The y- and z-direction results automatically.
The 3D tag point then lies in the centre of the
rectangle spanned by the 3 points.

11.1.2 Ball

11.1.2.1 Ball 1 point and diameter

For the configuration of a sphere in space, 1
point and an outer diameter are required.
For this point, select the uppermost point of
your spherical shape.
This is then also automatically the 3D tag point.

   
Specify the outer diameter of the sphere and
the desired projection type.

Type of projection

• Equal area (Lambert Azimuthal) - All areas
of the graphic are correctly displayed.

• Stereographic - Graphic is displayed true to
angle.

• Orthographically - Projection is normal to
the sphere on a tangential plane ➜ Graphic
is projected vertically.
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11.1.2.2 Hollow ball (1 point and diameter)

For the configuration of a hollow sphere in
space, 1 point and an inner diameter are
required.
For this point, select the lowest point within
your hollow sphere shape.
This is then also automatically the 3D tag point.

   
Further specify the inner diameter of the hollow
sphere and the desired projection type.

11.1.3 Cylinder

11.1.3.1 Cylinder (2 points + diameter)

For the configuration of a cylinder in space, 2
points and an outer diameter are required.
Specify two points on the cylinder workpiece
that are highest and aligned with the cylinder
axis.
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The 3D Tag point is obtained from the center of
the line passing through these two points.

   
Continue to specify the outside diameter of the
cylinder.

11.1.3.2 Hollow cylinder (2 points + diameter)

For the configuration of a hollow cylinder in
space, 2 points and an inner diameter are
required.
For this purpose, specify two points within the
hollow cylinder workpiece that are lowest and
in alignment with the hollow cylinder axis.
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The 3D Tag point is obtained from the center of
the line passing through these two points.

   
Furthermore, specify the inner diameter of the
hollow cylinder.

11.2 Mark 3D boundary

With the function Mark 3D Boundary you can generate a preview rectangle on your 3D object. The laser system is moved
to the tag point position and the outer boundaries of the graphics are displayed with the pilot laser.

With the help of the direction buttons you can change the position of
the tag point. The next possible position on the 3D object is used for
each step.
This means that the direction buttons cannot be used to move
(maneuver) freely in space. The system always follows the surface
shape.

With and the graphics are enlarged or reduced. In addition, they
can also be rotated to the le or right.
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With and the graphics are enlarged or reduced. In addition, they can also be rotated to the le or right.

11.3 Advanced settings

Here you can transform the 2D drawing area with all graphics - rotation, xy-mirroring and displacement.

Information
Set transformations are not displayed in the 2D drawing area. They only take effect shortly before the 2D
graphic data is converted into 3D graphic data, i.e. before projection.

Settings made here only affect the
current program:

• Each program can have a projection
with different "Advanced Settings".

• You can define the type of your xy-
axes if your system is not a standard
LWS.

• The settings "Head is moved" or
"Object is moved" have an effect on
the direction of movement of the
axes.
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12 Serial data and dynamic graphic element content

The Serial text and dynamic element content functions may be used to extend the content of a specific graphic
element using a variable component. This allows the creation of SpeedMark programs capable of reacting to external
circumstances during operation.

Information
By means of the variable editor, these contents can also be loaded in advance and then used by several
elements see "Variable editor".

A graphic element must be selected to select dynamic graphic element content. Then the Source tab can be used to
select the relevant content type.

Information
The types of content available for selection depend on the graphic element selected. e.g. graphic
elements such as rectangles or lines do not possess any content types.

The following types of content are available for selection depending on the graphic element selected:

• Serial number
• Expressions
• File expressions
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• Serial file
• Time stamp

12.1 Serial number

Serial number may be selected for the content source of text elements. The current text is then replaced by the current
serial number.

Information
SpeedMark currently only supports whole decimal numbers as serial text.

Before applying the Serial Text function, it is necessary to specify the
parameters such as start value, increments and end value.
It is also possible to specify that the end value is infinite.
The presentation format a serial number can be selected in the Format
section of the Serial Text settings. Via the dropdown a list of predefined
format strings can be accessed. Further it is possible to adapt a format
mask, by simply change it in the edit field.
The appearance of the formatting is displayed in the “Results” field for
preview purposes. It is also possible to request help with formatting
using the button containing a question mark.
Optional Actions allow actions to be carried out on specific events:

On End Value

• Reset to start value.
• Ask User
• End program

On Program Start

• Reset current value to start value.
• Keep current value.
• Ask for start value.
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12.2 Expressions

The Expressions source content makes it possible to replace the content of a
graphic element with the content of a variable or a calculated value - see "Simple
scripting".
To aid operation, a Variable Wizard is available to quickly request a list of all
available variables - For more information on variable types see "Variables".

12.3 Dynamic loading of vector graphics

The File Print Out source content is available for vector graphic type graphic
elements and allows the dynamic import of various vector graphics while a
SpeedMark program is running.
A valid file name must be added to the File Print Out field in the form of a variable of
a calculated string. As with Print Out, a Variable Wizard is also available.
It is also possible to specify whether an import should only be carried out if changes
are made to the file. That means that SpeedMark checks whether the current
imported graphic has changed its format in any way before a new import is carried
out.
Under certain circumstances, this can significantly affect the execution speed of the
created program.
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12.4 Seriendatei

The Expressions source content makes it possible to replace the content of a
graphic element with the content of a CSV file (that means, the data columns
must be separated by a special character.
This character must be selected during the import dialog. The files should be
saved as .TXT or .CSV.
With the button “Select file and data” the wizard for selection of file and data
will be started.

On this page the file selection is
performed.

   
With the data selection the delimiter and
the column can be selected.
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On the last page the start row and the line
increment are defined.

Aer finishing the wizard all settings are visible in the graphic properties.

Optional actions allow actions to be carried out on specific events:

On File Value

• Reset to start row.
• Ask User
• End program

On Program Start

• Reset current row to start row
• Keep current row
• Ask for start value
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12.5 Time stamp

Time stamp may be selected for the content source of text elements.
The current text is then replaced by today’s date.
It is also possible to specify the presentation format by using the Format
combo box.
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13 Control elements

Control elements may be used by SpeedMark programs while in progress to communicate with either the user or a
connected system to exchange data and react to events.

Each of the property’s dialogs can be opened by double-clicking the mouse.

The following control elements are available:

• Inputbox
• Dialog windows
• Value selection
• File selection
• Counter
• Variable editor
• Waiting for signal
• Set IO-Output
• Serial (RS232)
• TCP communication
• Delay
• Move axis
• Exhaust control
• Border marking
• Print working area
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13.1 Start element

With the start element it
is possible to set up the
behaviour of programs at the
start and end phase.

OPTIONS OF THE START ELEMENT
The automatic program loop repeats the program if it is not
cancelled or till the pre-set number of passes was reached.

Information
The start element will be marked with a "star"
symbol and a loop arrow from the end element to
the start element will be added to signal that the
program loop is active.

The option “Start exhaust at program start” sends according
to commands to the exhaust. Correct exhaust configuration is
necessary.
The MarkBusy signal can be automatically set with the
subsequent option.
The option automatic program starts at start signal waits with
program execution until a MarkStart signal comes. In combination
with automatic program loop it is very easy to work off a staple of
work pieces.
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13.2 Input window

The input window control element allows the user to enter configurable input values via the keyboard or barcode
scanner, for example.

Notice
A target input variable must be defined before the input window can be used.

It is also possible to specify the window title and a description of the input
field.
To be able to check the entries in the front end, it is possible to create an
input mask.
he button containing a question mark may be used to request detailed
information about input masks.
It is also possible to perform test inputs to validate the input mask.
The program execution is then interrupted during the program execution and
an input dialog opens in which it is possible to perform the user input.
The result of the input is then saved in the target variables for future use.

13.3 Dialog window

The dialog window control element allows displaying configurable messages to the user.
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It is possible to define the message type like:

• Standard
• Confirmation
• Warning
• Information
• Error

As well as the shown buttons:

• OK
• Cancel
• Yes
• No

The program execution is then interrupted during the program execution and
a message box is shown.

   
In tab advanced a variable can be defined which gets the value of the pressed
button. Also it is possible to display a dynamic message by defining an
appropriate variable

13.4 Value selection

The value selection control element creates a window with a value list the user can choose on single value.
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All values of the list must be defined in its own row. With “Index of default
value” it is possible to define the default selected value of the list.

Information
A target variable must be defined before the value selection
window can be used.

13.5 File selection

The file selection control element creates a window where the user can choose a filename.

The following file selection types are possible:

• Open dialog
• Save dialog

Information
A target variable must be defined before the file selection
window can be used.

   
In tab advanced it is possible to define a filter for file extensions in the
following form:
<Description1>|<Filter1>|<Description2>|<Filter2>|…
Additionally, it is possible to define a default directory.
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13.6 Counter

The control element counter enables the simple creation of a counting possibility within SpeedMark programs. The
internal counter will be incremented by the increment value at every call within the flow chart.

With the optional action “On program start” can be determined if the internal
counter should be saved or resetted.
Additionally, it is possible to link the internal counter to a variable.

13.7 Variable editor

Dynamic content (e.g., serial numbers, time stamps, etc.) as described in chapter "Serial data and Dynamic Graphic
Element Content" is only available to the specific element (e.g. text, barcode, etc.).

The control element variable editor allows for simple creation and editing of variable values. These variables are
not bound to a specific element in the program flow. Because of that it is possible to use them multiple times at any
position in the program.

The following edit options are available:

• Set value
• Timestamp
• Serial number
• Serial file

With the button "Create variable" it is possible to create new variables for the current marking program (The usage is
limited to text variables).
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VALUE/EXPRESSION
With set value it is possible to assign a constant value to selected variables.
Calculated expressions are not possible as all values are interpreted as text.

TIMESTAMP
With timestamp it is possible to assign the current timestamp to selected
variables with a defined format.
Timestamp formats can be chosen either via list or manual user input.

SERIAL NUMBER
With serial number it is possible to assign a serial number to selected
variables with a defined format.
Serial number formats can be chosen either via list or manual user input.
The serial number will be updated according to the settings on every
execution.
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SERIAL FILE
With serial number it is possible to assign the content of a text file.
Every column of the file can be associated to a variable.
On every execution the content of the next row will be assigned to the
variables .

13.8 Wait for signal

Waits for a configured signal from an I/O input or the user presses a button. If it is only necessary to wait for the user to
press a button, the Keyboard option must be selected in the Hardware combo box.

It is also possible to configure a suitable output message in the Message field.
Otherwise, all cards with system-configured I/O inputs can be selected in the
Hardware combo box.
When selecting multiple inputs, both signal settings must be met before
SpeedMark executes the program.

The signal inputs may be checked for:

• HIGH
• LOW
• Side HIGH/LOW
• Side LOW/HIGH

13.9 Set I/O output

This control element sets an I/O output of a system-configured I/O card. It is possible to set one or more outputs
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If the dot under Value is set to green, the output is set to HIGH.
If the dot under Value is set to grey, the output is set to LOW.
The output values are set by simply clicking on the dot.

13.10 Serial (RS232)

The control element Serial (RS232) allows the sending and receiving of data via a serial port. (This port must be defined
as described in chapter "Modules and Components" and in chapter "COM Port")

All received data will be written in the target variable.
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In tab extended receiving a terminal character and variable for receiving
status can be defined.

   
When sending the data can be written manually into the input field text
or be defined in a source variable - When using a source variable, the
value in input field text is ignored.

   
In tab “extended sending” a terminal character can be defined.

13.11 TCP communication

The control element TCP communication allows the sending and receiving of data via network. (This TCP port must be
defined as described in chapter "Modules and Components" and in chapter "TCP Module")
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All received data will be written in the target variable.

   
In tab extended receiving a terminal character and variable for receiving
status can be defined.

   
When sending the data can be written manually into the input field text
or be defined in a source variable ( When using a source variable, the
value in input field text is ignored).

   
In tab “extended sending” a terminal character can be defined.
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13.12 Delay

The Delay control element delays program execution for a set period.

This value may be specified in the Time field.
This control element is usually used when external systems (e.g., axes) require
specific time spans before proceeding with the actual marking.

13.13 Move axis

The move axis control element allows a simple control of connected axis.

With "current positon - apply" it is possible to take
over the current value of the axis position into the
input field.
Additionally, it is possible by clicking the arrow on the
Apply-Button to get the current position of the axis. If
a value is written into the target position field, clicking
Start moves the axis to the given position.
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13.14 Absaugung steuern

The exhaust control element allows a simple control of a connected exhaust.

13.15 Border marking

The control element Border marking allows the break the execution of the
program to adjust a work piece.
It can be determined on which signal the execution resumes.
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14 Basic flow chart programming

SpeedMark not only allows the basic marking of graphics using a laser, it also affects the flow of a program. Basic
programming methods can extend SpeedMark programs using a dynamic component with very little effort.

Information
Rudimentary programming knowledge offers a distinct advantage with this type of laser marking.
However, programming knowledge is not a requirement for the basic operation of the SpeedMark flow
control.

14.1 General

The Tools toolbar can be used to create new control and programming elements in the flow chart.

155



Basic flow chart programming

Information
In the SpeedMark default settings, the Tools toolbar is positioned vertically. However, it is presented
horizontally in this document for ease of illustration.

Such elements can be created simply by clicking on the respective symbol.
Such elements can be created simply by clicking on the respective symbol. Then move
the mouse to the flow diagram and insert the element by clicking the mouse on the
desired position.
The arrows positioned next to each element in the toolbar are used to access additional
elements.
All available control and programming elements are located on the toolbar beginning
with the traffic light symbol (Wait for Signal). An arrow is located next to each symbol and
clicking once on an arrow opens a list containing all the graphic elements available for
this group.

14.2 Variables

Variables are used in SpeedMark to transfer information from one control or programming element to the next.

All defined variables are available throughout
the program.
That means that you may, for example,
calculate an X position, save it in a variable
and then transfer it to a graphic element for
dynamic positioning.
The “List of Variables” dialog pictured above
may be opened directly using the (Project → of
Variables) menu. This dialog contains options
for creating, editing, and deleting variables.

CREATING VARIABLES
To create variables, enter a unique name for the variable in the Variable Name field. Then select a suitable variable type
from the adjacent list.

Information
A variable name may only be allocated once within a SpeedMark program.

SpeedMark supports the following types of variable:
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Type Description

Integer 4-byte integer (-231 … 231-1)

Text String consisting of ASCII/ANSI symbols

Floating-point number 8-byte real number (5.0*10-324 … 1.7*10308)

Integermatrix Matrix consisting of integer values

Text matrix Matrix consisting of text

Floating-point matrix Matrix consisting of floating decimal values

Clicking on the green plus symbol adds a new variable to the list which is then available for other applications.

EDITING VARIABLES
To edit variables, select the variable in the list by double-clicking with the mouse. All property values for the variables are
then transferred to the Variable Name, Variable type, and Dimension fields.

The type and dimension of the selected variable may now be edited (it is not possible to edit the variable name). The
changes are then accepted by clicking on the “Apply” button.

To change the variable name, select the variable you want to edit. Then click with the right mouse button on the
selection and select “Edit Variable Name” from the context menu.

DELETING VARIABLES
Variables can be deleted simply by selecting the variable to be deleted from the list, then clicking on the red X symbol.
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14.3 Basic programming elements

The programming elements give SpeedMark programs a dynamic component.
You can open the properties dialog for each of the elements with a double click.

Information
This chapter describes only the basic programming elements. All
advanced programming elements are described in detail in Chapter
"Simple Scripting".

14.3.1 Basic element properties

The Basic Element Properties tab is used to specify whether the element
should have a breakpoint (see chapter "Debug programs"), whether the
element is active and which title and comment should be displayed.
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14.3.2 Creating conditions

Conditions are used in branches and certain loops to specify the exact program. The design of such conditions is
described in this chapter and applied in the subsequent chapters.

Conditions can be used to check variables against fixed values or other variables using relational operators. A
condition must always be entered using the following format:

[Variable/Value] [Relational Operator] [Variable/Value] e.g., Variable > 3

Relational Operator Function

= The condition is true if the values to the le and the right of the operator are equal.

> The condition is true if the value on the le is greater than that on the right.

< The condition is true if the value on the le is less than that on the right.

>= The condition is true if the value on the le is greater than or equal to that on the right.

<= The condition is true if the value on the le is less than or equal to that on the right.

It is also possible to combine individual conditions using Boolean operators and parentheses.

[Condition1] [Boolean-Operator] [Condition2] e.g. (Variable > 3) And (Variable < 4)

Boolean Operator Function

Not Negates the result of the condition to which Not is applied. e.g. Not (2 > 3) → gives a true
result

And Combines the results of two conditions, whereby both conditions must be true for the
total result to be true. e.g. (2 > 1) And (5 > 2) →gives a true result

Or Combines the results of two conditions, whereby one condition must be true for the
total result to be true. e.g. (2 > 1) Or (2 > 5) → gives a true result

Xor Combines the results of two conditions, whereby one condition must be unequal to the
other for the total result to be true. e.g. (2 > 1) xor (2 > 5)
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14.3.3 Branch

The Branch elements may be used to easily implement alternative
program flows. The If-Then-Else field can be used to specify the path the
program should take.

If the condition is fulfilled, SpeedMark carries out the Then branch.

If the condition is not fulfilled, SpeedMark carries out the Else branch.

14.3.4 Incremental loop

The Incremental Loop enables a repetition of the part of the
program within the loop with definable parameters.
To set the incremental loop, a loop variable must be specified (by
selecting in the Loop Variable combo box)
A start value, an end value and the increments of the loop must
then be entered.

Information
The start value, end value and increments may also
be variables.
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14.3.5 Conditional loop

The Conditional loop enables a repetition of the part of the
program within the loop providing the given condition is true.
If the given condition is no longer valid, the program will continue
aer the loop.

14.3.6 Programm end

The Program end element ends the program immediately at that position and
does not execute any following program elements.
It is therefore possible, for example, to use branches and loops to trigger a
premature abortion of the program in certain instances.

14.3.7 Program abort

In comparison to the program end element the program abort cancels the execution in every case, where the program
end element is only jumping the program end.
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14.3.8 Comment/Note

This programming element creates a comment in a SpeedMark
program. This is used to provide information on the flow of such a
program for any other SpeedMark users working with it.
A suitable text can be entered in the Element Properties window.

14.4 Debug programs

To support the development of SpeedMark programs, SpeedMark provides several program debugging
functions:

• Incremental program execution
• Breakpoints
• Window for displaying current variable values
• Window for displaying any error messages

Symbols before Debug Mode is activated Symbols while Debug Mode is activated

14.4.1 Breakpoints

SpeedMark stops the current program execution when it reaches breakpoints and the program developer can evaluate
the current progress, view variable values and investigate any errors.

Before you can add a breakpoint to a program, you must select an element in the
flow diagram.
Then select the Switch Breakpoint function from the main menu (Start), the context
menu or the toolbar. → Re-executing the function deletes the breakpoint again.

Sets or removes a breakpoint in a program instruction.

Removes all breakpoints.
All elements containing a breakpoint are displayed in the flow diagram with a
simple red breakpoint symbol.
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14.4.2 Incremental program execution

The Debugging function is used to activate the SpeedMark Debug Mode. The program execution runs to the first
breakpoint or until any Program End is found.
SpeedMark stops the program execution at the first breakpoint it finds as per the instructions of the breakpoint.

The Single Program Instruction function executes the current element in the flow diagram, jumps to the next element
without executing it and waits for the next user input.

Continue Program causes SpeedMark to continue with the program without interruption until the next breakpoint.

Stops the program and ends the execution.

Pauses the program. The program can be continued using “Continue Program”.

14.4.3 Actual variable values

While SpeedMark is in Debug Mode, it is possible to request all current
variable values. The associated window can be opened using Menu → View →
Debug windows → Variable Monitoring.

14.4.4 Displaying Error Messages

It is possible to display error messages in SpeedMark during and aer the
execution of a program. The associated window can be opened using Menu
→ View → Debug windows → Error Messages.
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14.5 Dynamic positioning

Dynamic positioning uses variables to dynamically adjust the:

• Position
• Size
• Rotation

of graphic elements while a SpeedMark program is running.
The dynamic transformation of each graphic element is specified in the
Transformation tab in Graphic Properties

If no variables have been entered in the respective combo boxes, these
values will not be changed.

Information
The last section, Transformation Changes, is used to
specify whether SpeedMark should retain the applied
changes or reset them once the program has finished.

POSITION
A combo box in Dynamic Positioning (the upper section of the dialog) is
used to set the X and Y variables.
It is possible to specify whether these variable values should be given a
specific target as their position or whether they refer to a relative shi in
the current position.
The Target Anchor Point is used to specify which of the graphic
element’s anchor points should be used as the reference for the
positioning.
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SIZE
The size of the graphic element may also be dynamically adjusted by
selecting variables from the combo boxes.

ROTATION
To execute a dynamic rotation, it is possible to select a variable from the
“Angle” combo box.
It is also possible to specify whether a graphic element should be
rotated around an anchor point or a fixed point (also variable).

14.6 Pre- and post program

With the option pre- and post program, it is possible to insert a control flow before and aer the actual program
execution.

The option will be activated through Menu → Project → Pre- and post program.

PRE-PROGRAM
It is not possible to insert graphics into the pre program. This section serves only for initializing the system before the
actual program execution.
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POST-PROZESSING
It is not possible to insert graphics into the post program. This section serves only for shutting down the system aer the
actual program execution.
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15 Simple scripting

It is possible to fully automate SpeedMark programs using the advanced programming elements.

Information
Advanced programming knowledge offers an advantage with this type of laser marking. This type of
programming is mainly used in industrial environments employing repetitive tasks of long duration.

15.1 Advanced programming elements

CALCULATION/ ALLOCATION

The Calculation/Allocation element is used to create flow scripts in the SpeedMark script language.
This makes it possible to modify variables and access external files and components such as the laser or I/O cards.
A detailed specification of the SpeedMark script language and further explanations regarding the application of this
element can be found in Chapter "Scripting".
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JUMP LABEL

A jump label may be used to specify a position within a SpeedMark
program to which it is possible to make a direct jump.
These are sometimes required when it is necessary to jump back to the
beginning from various positions within large scripts.

JUMP TO JUMP LABEL

It is possible to use the Jump-to-Jump Label element in conjunction
with the Jump Label programming element introduced in the previous
chapter to jump directly to the jump label.
This element may be inserted at any point in the flow diagram.
The Jump Target combo box is used to select the target Jump Label.

JUMP TO SUB-ROUTINE
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This is used to jump to a sub-routine in the flow diagram. This is marked
with a jump label.
In contrast to Jump to Jump Label, this saves the current position.
It is therefore possible to return to this initial position using the
following element (Jump Back out of Sub-Routine) on completion and
continue with processing.

JUMP BACK OUT OF SUB-ROUTINE

Is used to jump back out of the sub-routine.

SUB-PROGRAM

The Sub-Program programming element is used to request a sub-
program.
Once the sub-program is complete, the next instruction in the program
is carried out.
The Parameter field can then be used to transmit information to the
sub-program.
It is also possible to dynamically request sub-programs. This is either
possible through the sub program name or the filename. To do
this, enter in the field a variable containing the name/path to the
appropriate sub-program.
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EXTERNAL PROGRAM

The External Program programming element is used by SpeedMark to
request an external program.
It is also used to give the application command line parameters.
The option exists to specify whether the SpeedMark program should
wait until the external program has stopped or not.
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15.2 Scripting

SpeedMark scripts may be used to fully automate program execution.

A full description of the syntax and all functions is contained in the document entitled “SpeedMark Scripting Reference”.

15.3 Master programs and sub-programs

Sub-programs are used to improve the structure of SpeedMark
programs and re-use individual program sections in other SpeedMark
programs.

172



Simple scripting

15.3.1 Adding or inserting sub-programs

A new sub-program can be added using Menu → File → New → New Sub-Program. This always assigns a sub-program
to a master program.

As sub-programs are saved as independent files, it is possible to assign them to other master programs as well.

By right-clicking on the master program in the Project Management window it is possible to link existing sub-programs
to the master program via the menu item “Add Existing Sub-Program”.

15.3.2 Managing sub-programs

Duplicating
If subprograms have similar structures and/or content it is easy to
create a new, similar subprogram. Using the "duplicate" function
contained in the context menu will create an exact copy of the
subprogram. So only the needed changes must be done aerwards.

   
Sorting
Sub-programs can be rearranged manually, so that they follow the
logical order (or reflect changes in the program logic). This can be
done by using drag and drop (mouse). Returning to a normal sort order
is also possible via the context menue that provides ascending and
descending sorting by name.
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IMPORT AND EXPORT
Export
Sub-programs can be exported via the context menue. Export is
available if a subprogram is selected and will save the program as an
OFC-file.
Import
The import can only be done when the main program is selected. It is
possible to import OFC files (single subprograms) or whole SPRX files.

   
If the SPRX contains subprograms itself, those will be imported
alongside the main program. Each of the imported parts will be suffixed
with SPRX-Filename to prevent any confusion because of duplicate
names.

Notice
The material database of the imported SPRX will not be integrated into the actual project! Speedmark will
try to match the parameter via name, id this is not possible the default parameter will be used!

15.3.3 Specifying transfer parameters

To dynamize sub-program requests it is possible to transfer parameters
from the master program.
A list of parameters consisting of local sub-program variables is
therefore defined in the sub-program start element. When the sub-
program starts, the variables are populated with the values from the
master program.
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It is also possible to transmit values from the sub-program back to the master program. The identifier “Ref” is then
prefixed to the name of the variable in the parameter list.

Example of a parameter list:

– VarZahl, Ref VarText

In the example above, the VarText value is transmitted back to the master program on completion of the sub-program.

15.3.4 Opening a sub-program

Sub-programs can be opened by the master program and other sub-
programs using the Sub-Program programming element.
All parameters to be transferred are specified in the parameter list,
separated by a comma.
This makes it possible to enter both variable and fixed values.

Information
In the case of reference parameters, a variable must be
entered when the sub-program is requested.
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16 Modules and components

In SpeedMark, modules are used in combination with components to form an extension basically representing
additional hardware components.

Information
The function - e.g., connection of a TLC2 card or Servida motor - is implemented by the module. Such
modules are configured by the system when it boots. In contrast, components are used to connect
SpeedMark and the installed modules. These components may then be configured accordingly in
subsequent steps.
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16.1 Component list

The configuration of modules and components is carried out
using the Tools → Laser system configuration.
This dialog is used to add new components, modify existing ones,
and delete those no longer required.
To add a new component, a component name must be entered,
and the appropriate module selected. Add a new component by
clicking on the plus symbol.
Once the components have been added, they can be fully
configured by double-clicking on them.

Information
Modules such as the laser controller only allow the
definition of an individual component. For other
modules such as I/O cards or motor controllers, the
number of components depends on the number of
in-built hardware components.

Components can be deleted by selecting the components then clicking on the Delete symbol.

16.2 Components Window

Various modules and components use additional windows in SpeedMark. These can be opened and closed using Menu
→ View → [ComponentName]→ [Windowlist].
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16.3 TLC2 laser controller

The TLC2 module and associated components control the Trotec laser system laser and scanner.

The module is integrated in SpeedMark and connects SpeedMark to the laser and scanner system, thus enabling the
laser marking or engraving of the graphics created in SpeedMark on a wide range of work pieces.

16.3.1 Functional range of module

The TLC2 module therefore fulfils the following functions:

• Laser control
• Scanner head control
• Configuration of the field correction file
• Configuration of the operating range
• Transformation of the operating range
• Control of the card I/Os
• Output of the laser system’s status
• Manual control of the scanner head mirrors
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16.3.2 Configuration

CONFIGURATION CONTROL
Tool Name Description

Open Tries to create a connection to the laser

Close Closes the open laser connection

Configuration Configuration of the card type

Save Saves the configuration contained in a .ini file.

Load Load the configuration in the specified .ini file.
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CARD TYPE
Determining the card type for the laser system used. For an Ethernet system, the
following IP address are already in use:

192.168.0.5 Ethernet laser rack
192.168.0.7 Ethernet laser rack (serial interfaces)
192.168.0.10 LWS SPS
192.168.0.50 optional IO’s

LASER TYPE (LASER CONFIGURATION)

This specifies the type of laser used in the laser system. Different types of lasers also allow the specification of additional
settings. In this case, the Advanced Settings button is activated automatically.

SCAN HEAD TYPE (LASER CONFIGURATION)

Defines the used scan head type. Depending on the selected head advanced settings may be available.

CURRENT LASER SETTINGS (LASER CONFIGURATION)
The current laser settings display the actual values used in relation to
the marking parameter settings.
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SETTINGS ON OPENING (LASER CONFIGURATION)
The Settings on opening define the marking parameter values to be
used when the card is initialised.
Further information about marking parameter settings can be found in
Chapter "Material Parameter Manager".

SCANNING LENS TYPE (MARKING FIELD)

Defines the used scanning lens type

FIELD DISTORSION (MARKING FIELD)

In the case of the TLC2 card, field distorsion is defined using a correction file specified using the Correction File input
field.
The program file is used to specify TLC2 card properties. This file is delivered with SpeedMark and the TLC2 card.

FIELD BORDERS (MARKING FIELD)

The laser system field borders are essentially defined by the optics used. The Field Borders Wizard is used to calculate
these borders incrementally.
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Caution
In order not to damage the scanner head with the mirrors, the operating range should always be slightly
smaller than the maximum field borders.

The Pilot Laser Wizard is used to adjust the pilot laser so that the offset of the laser pointer position is compensated
for by the actual laser beam used. This offset is determined by the difference in wave lengths of the pilot laser and the
processing laser.
The button “Field grid for distortion” marks a grid to create a distortion file.

FIELD TRANSFORMATION (MARKING FIELD)

The field transformation of the marking field enables the transformation of the actual marking field compared to the
marking field shown in SpeedMark.

I/O INPUTS
The I/O inputs display the status of all 16 of the card’s available I/O
inputs.
It is possible to change the name of the inputs by double-clicking on the
name.
The new names are then also available in elements such as the Wait for
Signal element.
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I/O OUTPUTS
The I/O outputs of all 16 of the card’s I/O outputs can be set using this
dialog.
An I/O output is set by clicking on the dot in the Value column (green =
HIGH, grey = LOW).
It is possible to change the name of the outputs by double-clicking on
the name.
The new names are then also available in elements such as the Set
Signal element.

SCANNER HEAD MANUAL CONTROL (CONTROL)
This dialog is used to manually move the mirrors for test and
maintenance purposes.
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FPGA
The tab-sheet FPGA shows a detailed overview
of the current state of the laser system.
All signals which are processed by the TLC2-
FPGA are presented in a signal overview.

VERSION (INFO)
The Version information mask supplies all the information relating to the version of
the card used.
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16.3.3 SpeedMark windows

LASER STATUS
The status of the laser is displayed in SpeedMark using the Laser Status
window.

SCANNER CONTROL
This window is used to manually move the mirrors for test and
maintenance purposes.

16.4 Laser Simulator
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The LaserSimulator module and associated components allows the usage of SpeedMark without laser system for testing
purposes or work preparation.

16.4.1 Functional range of module

The LaserSimulator module therefore fulfils the following functions:

• Simulation of a laser via the same interface TLC2 is using
• Graphical representation of the marking process
• Configuration of the operating range
• Control of the I/Os
• Output of the laser system’s status

16.4.2 Laser simulator configuration

CONFIGURATION CONTROL
Tool Name Description

Save Saves the configuration contained in a .ini file.

Load Load the configuration in the specified .ini file.

WORKING AREA
In this section it is possible to define the size of the working area. These values will be used by SpeedMark to calculate
the size of the drawing interface.

AUTOMATIC SIMULATION SAVES
It is possible to automatically save simulations as bitmap files.
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16.4.3 SpeedMark windows

LASER STATUS
The status of the laser is displayed in SpeedMark using the Laser Status
window.

16.5 Servida axis control

The Servida module and associated components support the control of Servida motors used to control axial and curved
engravings.

Information
All rights to the name Servida and the associated drive systems are retained by the Servida Corporation.
Further information about Servida drives can be found in the relevant documentation.

The motors can be controlled manually and by using the scripting functions.
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16.5.1 Functional range of module

The Servida module fulfils the following functions:

• Initialisation of the motors
• Control of the motors using scripting functions
• Manual control of the motors

16.5.2 Configuration

CONFIGURATION CONTROL

Tool Name Description

Open Tries to establish a connection to a Servida motor

Close Closes an open connection

COM-Port COM port used to communicate with the Servida motor

Save Saves all configurations

Load Loads all configuration settings

Load Parameters Load template parameters
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GENERAL SETTINGS

Setting Description

Axis Type Specification of axis type. The available options are planar axis or rotation
axis.

Encoder Resolution Number of motor steps per revolution or per mm (planar)

Slope Slope of the thread in mm per rotation

Gear Factor Transfer factor of gears

Max. Position Error Maximum position error (drag error) in motor steps

PWM Limit Power limit

Engine break active For motors with engine break

Max. Temperature Maximum motor temperature for cut off

Deactivate Hardware Limits Activates/deactivates limit switch signals

Hand button Activate or swap hand buttons or invert signals

Info Additional motor information

189



Modules and components

CONTROL

Setting Description

Move speed (Motion) Motor move speed in mm per second or rotations per
second

Hand speed (Motion) Motor move speed in mm per second or rotations per
second

Acceleration (Movement) Acceleration of the motor

P Proportionality factor

I Integral factor

D Differential factor
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IL Integral limit

A Acceleration feed forward

InPos-Fenster Tolerance range for positioning

InPos-Timer Delay time for positioning

Soware limits activated Activates the soware limits (position borders) of the
motor.

Min. Position The smallest position which can be reached in ° or mm
(planar)

Max. Position The greatest position which can be reached in ° or mm
(planar)

Offset The zero-point offset of the positions in ° or mm (planar)

Invert Positions Inverts the motor positions

Zero Point Sets the current motor position to the zero point (modifies
the offset value)

Speed (Referencing) Maximum motor speed in mm per second or rotations per
second during referencing

Acceleration (Referencing) Acceleration of the motor during referencing

Direction Direction of the reference movement (positive or negative
limit switch)

Referencing Starts referencing

Index Interval Interval in motor steps aer a successful referencing
between the limit switch and the first index marker found

Status Motor status signals

Reset Resets the motor status signals

Target position The target of the next movement in ° or mm (planar)

Position Current motor position in ° or mm (planar)

Start Starts the movement to target position

Stop Stops the current movement

<< Fast movement in a negative direction

< Slow movement in a negative direction

> Fast movement in a positive direction

>> Slow movement in a positive direction

Inputs/Outputs Current input and output status
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16.5.3 SpeedMark windows

MANUAL AXIS CONTROL
This window is used to manually adjust the motor position in SpeedMark.

16.6 Relop I/O

The Relop I/O module and associated components support the control of a Relop I/O card by SpeedMark.

16.6.1 Functional range of module

The Relop I/O module fulfils the following functions:

• Initialisation of a Relop I/O card
• Provision of functions for accessing the I/O ports
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16.6.2 Configuration

CONFIGURATION CONTROL

Tool Name Description

Open Tries to establish a connection to the I/O card.

Close Closes an open connection.

Card Card Index is used to specify which card to communicate with.

Save Saves all configurations.

193



Modules and components

Load Loads all configuration settings

SETTINGS

Setting Description

Output Port Index Displays the switching status of all 16 outputs. The individual outputs can be switched
manually by clicking on the grey or green dots.

Output Port Index Displays the index number of each output.

Output Port Name Displays the name of each output. This name can be modified. Select an output, move
the mouse over the name field, then click once with the le mouse button. The name is
now highlighted in blue and can be edited.

Invert Output Port Negates individual or all outputs.

Input Port Displays the switching status of all 16 inputs.

Input Port Index Displays the index number of each input.

Input Port Name Displays the name of each input. This name can be modified. Select an input, move the
mouse over the name field, then click once with the le mouse button. The name is now
highlighted in blue and can be edited.

Invert Input Port Negates individual or all outputs.

Initialisation Value Defines the switching status of the outputs when the card is opened.

Deinitialisation Value Defines the switching status of the outputs when the card is closed.

Auto Test Delay Carries out a test on the card in which all outputs and inputs are switched in turn. The
delay is used to set the time between the switching operations.

16.6.3 SpeedMark windows

The Relop I/O module use two windows in SpeedMark. One window for the Output-Port and another for the Input-Port.

16.7 B&R Modbus TCP IO

The B&R-Modbus module and associated components support the control of a B&R Modbus TCP IO controller by
SpeedMark.

16.7.1 Functional range of module

The B&R-Modbus module fulfils the following functions:

• Initialisation of a B&R-Modbus controller
• Provision of functions for accessing the I/O ports
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16.7.2 Configuration

CONFIGURATION CONTROL

Tool Name Description

Open Tries to establish a connection to the B&R Modbus controller

Close Closes an open connection

Save Saves all configurations

Load Loads all configuration settings

SETTINGS

Setting Description
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Output Port Displays the switching status of all 16 outputs. The individual outputs can be
switched manually by clicking on the grey or green dots.

Output Port Index Displays the index number of each output.

Output Port Name Displays the name of each output. This name can be modified. Select an output,
move the mouse over the name field, then click once with the le mouse button.
The name is now highlighted in blue and can be edited.

Invert Output Port Negates individual or all outputs.

Input Port Displays the switching status of all 16 inputs.

Input Port Index Displays the index number of each input.

Input Port Name Displays the name of each input. This name can be modified. Select an input,
move the mouse over the name field, then click once with the le mouse button.
The name is now highlighted in blue and can be edited.

Invert Input Port Negates individual or all outputs.

Initialisation Value Defines the switching status of the outputs when the controller is opened.

Deinitialisation Value Defines the switching status of the outputs when the controller is closed.

16.7.3 SpeedMark windows

The B&R-Modbus module use two windows in SpeedMark. One window for the Output-Port and another for the Input-
Port.
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16.8 RunScreen

The RunScreen module and associated components generate a configurable dialog while a SpeedMark program is
being processed.

16.8.1 Functional range of module

The RunScreen module therefore fulfils the following functions:

• Displays a dialog while a SpeedMark program is being processed.
• Configures the dialog.
• Provision of functions for adjusting the dialog while the program is being processed.
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16.8.2 Configuration RunScreen

CONFIGURATION CONTROL

Tool Name Description

Save Saves all configurations

Load Loads all configuration settings

GENERAL

Setting Description

Input Field Visible Sets which input field should be visible

Button Visible Sets which button should be visible

Aktive Registerkarte Auswahl der aktiven Registerkarte

Registerkarte Log sichtbar Einstellung, ob Registerkarte Log sichtbar sein soll

Registerkarte Bild sichtbar Einstellung, ob Registerkarte Bild sichtbar sein soll
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Bild Auswahl des Bildes das bei Registerkarte Bild angezeigt werden soll.

PASSWORDS
The Passwords tab is used to specify whether a password is required for the
RunScreen service menu.
When a program is interrupted, the service menu opens, and active password
protection ensures that the program may only be closed by entering the valid
password.

   
The adjacent illustration shows the RunScreen service menu. It can be used
to select from various options to continue processing when a program is
interrupted (ESC key).

16.8.3 SpeedMark windows

The RunScreen module does not support any windows in SpeedMark.

16.9 COM Port

The COM port module and associated components support the control of the COM ports available on the PC system.

16.9.1 Functional range of module

The COM port module fulfils the following functions:

• Initialisation of the selected COM ports
• Provision of functions for accessing the COM ports.
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16.9.2 Configuration

CONFIGURATION CONTROL

Tool Name Description

Open Tries to establish a connection to the COM interface

Close Closes an open connection

Port The COM port determines which COM interface to use in the PC

Save Saves all configurations

Load Loads all configuration settings

SETTINGS

Setting Description
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Baud rate Sets the transmission rate

Parity Determines whether an even or uneven number of bits should be transmitted

Data Bits Determines the number of bits transmitted

Stop Bits Determines the number of stop bits transmitted

RTS Control Interface handshake

DTR Control Interface handshake

16.9.3 SpeedMark windows

The COM port module does not use any windows in SpeedMark.

16.10 TCP module

The TCP module and associated components support the data exchange through built in network capabilities.

16.10.1 Functional range of module

The TCP module fulfils the following functions:

• Initialisation of the selected IP address
• Testing the connection by sending and receiving data within the configuration dialog
• Test client shipped with SpeedMark setup

201



Modules and components

16.10.2 Configuration TCP

CONFIGURATION CONTROL

Tool Name Description

Open Opens a channel on the PC to receive and send data

Close Closes an open connection

IP adresse IP address of this computer

Port Communication port

Save Saves all configurations

Load Loads all configuration settings
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16.10.3 SpeedMark windows TCP

The TCP module does not use any windows in SpeedMark.

16.11 Axis simulator

The axis simulator module and associated components allows the usage of SpeedMark without axis for testing purposes
or work preparation.

16.11.1 Functional range of module

The axis simulator module fulfils the following functions:

• Simulation of an axis
• Definition of work area (limits)

16.11.2 Configuration

CONFIGURATION CONTROL

Tool Name Description

Save Saves all configurations

Load Loads all configuration settings
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SETTINGS

setting Description

Limits enabled Determines if this axis has limits or not

Min Position Minimum position of this axis

Max Position Maximum position of this axis

16.11.3 SpeedMark windows

The axis simulator module does not use any windows in SpeedMark.
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17 Extensions

Extensions are used to provide additional functions within SpeedMark.

Information
In contrast to modules, extensions directly increase the functional range of SpeedMark. It is therefore also
possible use the extension function of modules.
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17.1 Configuration of extensions

The configuration of extensions is carried out using the Tools →Program Extensions menu.

17.2 Extensions window

Various extensions use additional windows in SpeedMark. These can be opened and closed using Menu → View →
Program Extensions → [Extension] → [Windowlist].

17.3 Program selection extension

The program selection extension is used to make a simple selection of SpeedMark programs from a configurable
directory list.

17.3.1 Functional range of extension

The Program Selection extension fulfils the following functions:

• Selects and loads programs from a list.
• Configures the directories used to generate the program lists.
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17.3.2 Configuration extensions

DIRECTORY SELECTION
Directory Selection displays a list of all configured directories which can be used to search for SpeedMark programs.

The Directory Selection input field is used to specify directories which are added to the list using the “Add” button.

CONFIGURATION FILE
The Configuration File input field is used to enter the directory and name of the configuration file used.

17.3.3 SpeedMark windows

The Program Selection window displays a list of all the SpeedMark
programs found which may then be loaded into SpeedMark using the
Load Program button.
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18 DirectMark

18.1 What is DirectMark

Simply control your Trotec Laser from your favorite graphic program.
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18.2 Starting the DirectMark Soware

Information
To start the DirectMark soware an external program (e.g., CorelDraw) must be used, which starts the
DirectMark program directly aer printing.

LICENSING
At every start, the soware checks if a valid license key is available. If not provide a valid license key according to the
instructions - see also "Advanced options".

SCOPE OF APPLICATION OF SOFTWARE
With the DirectMark soware, you can print both vector and bitmap graphics from third-party programs to DirectMark
and mark them with the laser.

18.3 Creation of content to mark

Information
The following examples and explanations use the graphic program CorelDraw®. But the instructions can
be performed with other graphic programs as well.
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18.3.1 Preparations in graphic program

1. To avoid distortions and cut of graphics, the page size within the graphics program be equal to the size of the
marking field. A smaller page size is no problem.

2. Insert the graphic to mark as usual.

3. Print your graphic with the normal printing function.

Some programs (e.g., Word) have a quick print function. But with the first use of DirectMark you should use the normal
print function to setup necessary printer properties.
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Notice
On systems with more than one printer attached, please choose the correct one –DirectMark Printer
Driver.

Within the printing dialog of your graphic program, you can setup the printer properties for the printing process.

Information
The option “copies” is not supported by DirectMark. This setting must be configured within DirectMark
printer properties.

18.3.2 DirectMark Print Properties

The DirectMark printer properties – as shown above – can be started via the button properties within the printing dialog
of your graphic program.
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JOB PROPERTIES
In the section material you can setup the used material for the
work piece. The button with the pen allows editing of the material
parameters .
With the execution mode you can choose between photo and
logo.
In photo mode the marking will be performed row by row. In this
case the execution is slower.

  
Black and white graphics can be marked in logo mode. The
graphic will be vectorized which speeds up the marking
significantly.
The section graphic is used to change the resolution (in DPI), the
dithering (only photo mode), the amount of sub pixels, the pixel
correction and the quantity.
 
With the option Rotary it is possible to process rotary jobs. Only
the diameter of the work piece must be specified.
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PRINTER-PROPERTIES
In the section print mode you can choose if Quick-Print mode
or Quick-Positioning mode should be used. In Quick-Print mode
DirectMark instantly starts the marking process when the graphic
program has finished the creation of the print job - The marking
process will only be started automatically when there are no
pending failures of the system.

  
In Quick-Positioning mode the DirectMark print job list will
be opened aer the creation of the print job. In this case a
positioning of the work piece can be done. The marking process
will then be started manually. The size values height and width
are used to define the size of the printing area. These size values
must be equal or smaller to size of the real marking field. With
the update button the current size of the marking field can be
requested.
The material parameter can be edited by pressing the Material
Parameter button. The option “Exhaust – Start automatically” will
start a connected exhaust before the beginning of the marking
process.
  
In the section bitmap rendering you can determine how the
detection of bitmaps in relation to the material parameter shall be
done.

MATERIAL PARAMETER MANAGER
The material parameter manager allows the creation and editing of materials for the marking process.
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In the parameter table are 16 marking colors per material defined. Every color defines it own parameter settings. Single
colors can be activated or deactivated.

The print mode defines the kind of executions for the color.

• Bitmap: This parameter will be used for bitmaps.
• Vectors: If a vector line (width of the line must be hairline) is found in the graphic, the corresponding color will be

applied to it.
• Positioning: When vectors are found which have this color, then these vectors will not be marked. Instead, they can

be used for positioning.

18.4 Marking with DirectMark

Aer creation of the print job by the graphic program, the data
will be sent to DirectMark and is ready for marking with the laser
system.

  
DirectMark automatically detects if a new print job is available
and opens the DirectMark window.

OSITIONING OF PRINT JOBS
With the button Border marking it is possible to perform
positioning of the print job or the work piece. It is also possible to
determine if the whole bitmap should be border marked or only
the positioning graphics.

  
With the arrow buttons it is possible to move the print job. The
button in the middle resets changes already made. Move changes
are applied by ending Border marking.
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MARKING ON WORK PIECESEDIT PRINT JOB LIST
With the Start button the marking of the print job with the laser
system will be started. The button Stop cancels an already
running marking process. In this case the print job will not be
deleted.

  
On marking end the print job will be deleted and is not available
anymore. At the end of the marking the marking time will be
shown in the bottom le of the window.

EDIT PRINT JOB LIST
Moreover, it is possible to edit the list of pending print jobs with a
right mouse button click.

   
Print jobs can be deleted, or the number of copies can be
changed. Single jobs can also be copied or moved to the archive.
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18.5 DirectMark Options

18.5.1 Single Options

The option “Automatic border marking” starts the border marking
automatically when a print job is available. The option “Manually
start QuickPrint jobs” deactivates the print mode setting of the
printer properties .

  
The option “Start exhaust with print job” starts a connected
exhaust before the beginning of the marking process. The option
“Use MarkStart signal” waits with the marking process until a
MarkStart signal is detected.

JOB ARCHIVE
From the job archive it is possible to take over archived jobs back
to the print job list. Archived jobs can be simple moved or copied.

  
All available actions can be accessed by right clicking an archive
file in the list.
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JOB HISTORY
The job history shows all jobs that have been executed. This data
includes duration, time stamp and execution status.

  
  

Z-ACHSEN OPTIONEN
Provides the options to move and if necessary, reference the z-
axis.

Information
This entry is only active if an electrical z-axis is
installed.

   

ROTARY ENGRAVING OPTIONS
Provides the option to set up the position of the rotary engraving
unit, to move and if necessary, reference the axis of the rotary
unit.

Information
This entry is only active if a rotary engraving unit is
installed.
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18.5.2 Advanced options

With the advanced options it is possible to configure the
laser system , change the language or perform the soware
registration. - Aer a laser system configuration DirectMark should
be restarted.

   

LOCK ACCESS
By default, DirectMark is shipped with limited access to avoid accidental changes of the configuration.

Notice
DirectMark is configured with an initial password. Please change this password to protect your system
from unauthorized access. The initial password is “admin”.

Admin-mode can be enabled with the button “Login” to change
or reset the locks.

   
Now the function groups can be locked, or the password can be
changed.
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Within the printer properties on tab sheet “Info” it is possible to
change into administrator mode – aer entering the password –
to change locked settings.

18.6 Rotary engraving

HOW TO ACTIVATE ROTARY ENGRAVING
The printing dialog offers the option to activate the rotary
engraving. It is essential to define the exact diameter of the
working piece to prevent gaps or overlapping sections.

   
Information
Be aware that there is no test at this point if a rotary engraving unit is installed . Check the configuration to
make sure, the job can be executed correctly!

ADVANCED OPTIONS
The advanced options let you define the marking type. This can
either be an outside engraving (e.g., pipes) or inside engraving
(e.g., rings).
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Bitmap lines will define the count of pixel rows that will be marked before the rotary unit moves to the next segment (by
rotating the axis). Many lines speeds up the marking process but entails the risk, that focus is lost at the edges (which
will be visible as a not uniform marking result). So, it is necessary for each working piece to find an acceptable tradeoff
between speed and quality.

CONFIGURING A ROTARY ENGRAVING UNIT
1. Please switch to DirectMark

Advanced Options and login to
access laser configuration (Default-
Password: admin). Select „Configure
laser system“.
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2. In the Tab "Components" create a
new rotary unit by adding a Servida-
module.

   
3. Open the configuration of the new

component by double clicking it.
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4. Load the rotary parameters from the
according template.

   
Verify that the axis type is set to "rotation"
aerwards.

   
5. Select the COM port that connects

the RGV to the PC.
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6. Now save the configuration of the
rotary engraving unit.

   
7. Connect the rotary engraving unit by

clicking on "Open".

   
8. As the final step you have to assign

the newly added RGV as the A-Axis in
the System configuration tab.
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19 Appendix

19.1 Utilities

SpeedMark Utilities are a collection of utility programs which support the user outside of the actual SpeedMark soware
in the work with the Trotec laser system. These programs can be found under the SpeedMark installation directory in the
folder Utilites.

19.1.1 Speedmarker Diagnostics

With SpeedMarkerDiagnostics a diagnosis of the laser system can be done step by step. The diagnosis will be started
with the button “Start Diagnosis”. Follow the instructions on the screen to get a correct result.

Notice
During the usage or start of SpeedMarkerDiagnostics it is not allowed to run SpeedMark, because there
would be no access to the relevant hardware components.
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19.2 Barcodes

19.2.1 Barcode 1D list

Code 11

Code 2 of 5 Standard

Code 2 of 5 Interleaved

Code 2 of 5 IATA

Code 2 of 5 Matrix

Code 2 of 5 Data Logic

Code 2 of 5 Industrial

Code 39

Code 39 Extended

EAN-8

EAN-8 + 2 Digits

EAN-8 + 5 Digits

EAN-13

EAN-13 + 2 Digits

EAN-13 + 5 Digits

EAN/UCC 128

UPC 12

Codabar 2 Widths

Service-ID

Code 128

Deutsche Post Leitcode

Deutsche Post Identcode

ISBN 13 + 5 Digits

ISMN

Code 93

ISSN

ISSN + 2 Digits

Flattermarken

GS1 DataBar (RSS-14)

GS1 DataBar Limited (RSS)

GS1 DataBar Expanded (RSS)
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Telepen Alpha

UCC / EAN-128 (GS1-128)

UPC Version A

UPC Version A + 2 Digits

UPC Version A + 5 Digits

UPC Version E

UPC Version E + 2 Digits

UPC Version E + 5 Digits

USPS PostNet 5

USPS PostNet 6

USPS PostNet 9

USPS PostNet 10

USPS PostNet 11

USPS PostNet 12

Plessey

MSI

SSCC 18

Transaction-ID

LOGMARS

Pharmacode One-Track

PZN (Pharma Zentralnummer)

Pharmacode Two-Track

Code 128 Subset A

Code 128 Subset B

Code 128 Subset C

Code 93 Extended

Australian Post Customer

Australian Post Customer 2

Australian Post Customer 3

Australian Post Reply Paid

Australian Post Routing

Australian Post Redirection

ISBN 13

Royal Mail 4 State (RM4SCC)

EAN 14 (GTIN 14)

NVE 18
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Japanese Postal

Korean Postal Authority

GS1 DataBar Truncated (RSS-14 Truncated)

PLANET 12 digit

PLANET 14 digit

USPS Intelligent Mail® Barcode or IM® Barcode

Plessey Bidirectional

Telepen

GS1 128 (EAN/UCC 128)

ITF 14 (GTIN 14)

KIX – Dutch Postal Code

DAFT Code

Italian Postal 2 of 5

DPD

HIBC LIC 128

HIBC LIC 39

HIBC PAS 128

HIBC PAS 39

19.2.2 Barcode 2D list

PDF417

PDF417 Truncated

MaxiCode

QR-Code

Data Matrix

Codablock-F

GS1 DataBar Stacked (RSS-14 Stacked)

GS1 DataBar Stacked Omni directional (RSS-14 Stacked)

GS1 DataBar Expanded Stacked (RSS Expanded Stacked)

Micro PDF417

Aztec Code

Micro QR-Code

HIBC LIC Data Matrix

HIBC PAS Data Matrix
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HIBC LIC QR-Code

HIBC PAS QR-Code

HIBC LIC PDF417

HIBC PAS PDF417

HIBC LIC Micro PDF417

HIBC PAS Micro PDF417

HIBC LIC Codablock-F

HIBC PAS Codablock-F

QR-Code 2005

19.3 Command line parameters

COMMAND LINE STRUCTURE:
SpeedMark.exe key1:value1 key2

Parameter Description Example

user Username to log on SpeedMark.exe user:operator password:operator

password Password of the user
defined with parameter
user.

SpeedMark.exe user:operator password:operator

recreatematerialdatabase Creates a new default
material database. Old file
is overwritten.

SpeedMark.exe recreatematerialdatabase

disableautostarts Avoids the start of any
project or scripted
runscreen defined in
settings.

SpeedMark.exe disableautostarts

loadproject Loads the given marking
project

executerunscreen Executes the given
advanced scripting project

19.4 PDF-Import

19.4.1 Prerequisites

PDF-Import in SpeedMark supports any File that meet PDF standard 1.5 or higher. Regular PDFs do not save any
additional layer information, so the mapping from layer to material parameter must be done by name only. Many
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programs offer the possibility to export to PDF, but depending on the setttings and the selected PDF standard the
resulting file structure looks different. SpeedMark should support all files as long as the meet the PDF standard 1.5+.

Following programs have been tested:

• CorelDraw X3
• CorelDraw X5
• CorelDraw X7
• Illustrator CS5

19.4.2 Restrictions

PDF (like DXF) in SpeedMark is used for the import of vector data (e.g. cutting lines, etc.) and for extraction of registration
marks. Because of this content elements like bitmaps, texts and additional graphics information (fillings, line width,
line color) are discarded by the import. Additional layer information (like layer colors) – that can be saved by 3rd-party
soware (e.g. CorelDraw) – do not comply with the PDF standard and are saved in proprietary structures inside the PDF
file. Those informations will not be processed and used by SpeedMark.

Please consider the following details:

• Texts must be converted to vector data to get processed.
• Vector data that should represent special information (e.g. cutting lines) have to be placed on a separate layer.
• Layer names should be unique (because the mapping is only done by name), otherwise data from those layers will

be merged in one element.
• Only the first page of a PDF will be analysed (other pages are ignored).
• The import does not follow any links to other PDFs.
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